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Company Information 
CPR Tools, Inc. 
905 Industrial Blvd. 
LaBelle, FL 33935 
Tel: 863-674-0120 
Fax: 863-674-0066 
Email: info@cprtools.net 
Web: www.cprtools.net 

CPR Tools has been a leader in the field of data recovery for nearly three decades.  In meeting 
the needs of our own data recovery technicians and in our role as educators to the industry, 
CPR Tools has developed tools designed to simplify and automate tasks in the data recovery 
lab.  PSIClone™ is such a tool. 

Designed for use in the field or the lab, PSIClone™ will provide years of consistent and reliable 
service.  

Trademark Disclaimer 
All referenced trademarks, product names and company names or logos cited herein are the 
property of their respective owners.  These include, but are not limited to Microsoft®, 
Windows®, and Windows XP® which are registered trademarks of Microsoft Corporation in the 
United States, other countries, or both and ‘Recover My Files’ and ‘Mount Image’ which are 
registered trademarks of GetData Pty, Ltd. 
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Limited Warranty Statement 
CPR Tools, Inc. products are warranted by CPR Tools, Inc. against manufacturing defects in 
material and workmanship under normal use for one (1) year from the date of purchase from 
CPR Tools, Inc. or its authorized re-sellers.  To receive warranty service, users must register 
their products at http://www.cprtools.net/.  

EXCEPT AS PROVIDED HEREIN, CPR TOOLS, INC. MAKES NO EXPRESS WARRANTIES AND ANY 
IMPLIED WARRANTIES, INCLUDING THOSE OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE, ARE LIMITED IN DURATION OF THE WRITTEN LIMITED WARRANTIES 
CONTAINED HEREIN. EXCEPT AS PROVIDED HEREIN, CPR TOOLS, INC. SHALL HAVE NO 
LIABILITY OR RESPONSIBILITY TO CUSTOMER OR ANY OTHER PERSON OR ENTITY WITH 
RESPECT TO ANY LIABILITY, LOSS OR DAMAGE CAUSED DIRECTLY OR INDIRECTLY BY USE OR 
PERFORMANCE OF THE PRODUCT OR ARISING OUT OF ANY BREACH OF THIS WARRANTY, 
INCLUDING, BUT NOT LIMITED TO, ANY DAMAGES RESULTING FROM LOST OR CORRUPTED 
DATA, INCONVENIENCE, LOSS OF TIME, PROPERTY, REVENUE, OR PROFIT OR ANY INDIRECT, 
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, EVEN IF CPR TOOLS, INC. HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

Some states do not allow the limitations on how long an implied warranty lasts or the exclusion 
of incidental or consequential damages, so the above limitations or exclusions may not apply to 
you. 

In the event of a product defect during the warranty period, obtain return approval from CPR 
Tools, Inc. prior to product return. CPR Tools, Inc. will, at its option, unless otherwise provided 
by law: (a) correct the defect by product repair without charge for parts or labor; (b) replace 
the product with one of the same or similar design. All replaced parts and products, and 
products on which a refund is made, become the property of CPR Tools, Inc. New or 
reconditioned products may be used in the performance of warranty service. Repaired or 
replaced products are warranted for the remainder of the original warranty period. You will be 
charged for repair or replacement of the product made after the expiration of the warranty 
period. 

This warranty does not cover: (a) damage or failure caused by or attributable to acts of God, 
abuse, accident, misuse, improper or abnormal usage, failure to follow instructions, improper 
installation or maintenance, alteration, lightning or other incidence of excess voltage or current; 
(b) any repairs other than those provided by CPR Tools, Inc. or its authorized representatives; 
(c) consumables such as fuses or batteries; (d) cosmetic damage; (e) transportation, shipping 
or insurance costs; or (f) costs of product removal, installation, set-up service adjustment or 
reinstallation. 

This warranty gives you specific legal rights, and may also have other rights which vary from 
state to state. Terms are subject to change at any time. See company policies at 
www.cprtools.net for latest warranty information. Optional extended warranty coverage for 
select products is available for purchase from CPR Tools, Inc. 

Users may purchase extended warranties online at www.cprtools.net. 

http://www.cprtools.net/
http://www.cprtools.net/
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Introduction 
Congratulations on your purchase of PSIClone™ from CPR Tools.  PSIClone™ was developed by 
CPR Tools’ engineers in answer to our own data recovery lab technicians’ requests, PSIClone™ 
is packed with useful features which make it a unique product. 
Designed with forensic data integrity in mind, a primary feature of PSIClone™ is that the user is 
unable to write to the ‘source’ side of the device (Side A).  This built in ‘Write Protect’ feature is 
one of the advanced features that your new PSIClone™ contains. 
While PSIClone™ is primarily a drive-to-drive cloning and imaging device, it stands out from 
other such devices because, unlike others in this category, PSIClone™ can be used to ‘clear’ 
data in accordance with NIST 800-881 specifications to ensure complete destruction of personal 
information.  
The free host utility software, CPR Toolbox™ extends PSIClone™ functionality with features not 
found in any package at twice the price.  PSIClone™ performs and provides tremendous value. 
At CPR Tools we truly believe that data recovery engineers are the best people to design data 
recovery tools.  If you have any comments, questions or ideas for enhancements or additions to 
the functionality of PSIClone™, email (psiclone.support@cprtools.net) or contact us via the 
contact form at http://www.cprtools.net.  

What’s New in PSIClone™? 
Simply put: A LOT!!  This exciting new release of PSIClone™ and the CPR Tools Utilities Suite 
includes version 5 of the CPR Toolbox™ host companion software.  Featuring a new, sleek and 
fully redesigned interface, CPR Toolbox™ version 5 extends PSIClone™ functionality with 
powerful new recovery tools, including:  
• Enhanced Imaging Control 

o PSIClone™ now allows for custom filenames when creating image filesets. 
• iFirmware™ 

o Work with hard drive firmware modules 
o AIR: Automatic Identification & Repair 

• ADR 
o Perform advanced data recovery techniques 

These features add to the robust list of PSIClone™/CPR Toolbox™ capabilities, which include: 
• Compression 

o PSIClone™ can employ a compression algorithm during the creation of image files.   
• The ability to mount a filesystem on a drive connected to PSIClone™  

o USB 2.0 connection to a host system running CPR Toolbox™ required. 
o In this mode, PSIClone™ employs a USB 2.0 Write Block – no write operations are permitted 

to drives in Mass Storage Mode while connected to PSIClone™ 
• Partition Clone 

o Provides the ability to quickly clone a logical partition. 
• FastClone 

o Copies only allocated sectors within a detected filesystem. 
• eDrive™ 

o Allows for the creation of known errors on drives.  This feature is helpful in software or 
hardware validation and may be used for training. 

• gClone™ 
o Allows cloning of sectors which have been remapped by a drive’s defect mapping mechanism 

 

                                          
1 http://csrc.nist.gov/publications/nistpubs/800-88/NISTSP800-88_rev1.pdf 

mailto:psiclone.support@cprtools.net
http://www.cprtools.net/
http://csrc.nist.gov/publications/nistpubs/800-88/NISTSP800-88_rev1.pdf


 

Getting Started 
Before starting to use your new PSIClone™, take a moment to examine the contents of your 
PSIClone™ package.  

1 x PSIClone 

1 x Documentation/CPR Tools Utilities Suite CD 

2 x SATA Data/Power Cables 

2 x PATA Data Cables 

1 x USB Cable2 

1 x AC Power Supply 

1 x AC Power Cord  

Figure 1 illustrates the entire contents of your PSIClone™ package. 

 

 
PSIClone™ (1) 

 
Documentation/CPR Tools Utilities Suite CD (1) 

  

    
SATA + Power Cables (2) PATA Cables (2) USB Cable (1) AC Power supply & cord (1) 

Figure 1 - PSIClone™ Package – Contents 

Additional cables and accessories, including many hard drive adapters which extend PSIClone 
functionality, may be purchased at www.cprtools.net/store.    

                                          
2 USB cable provided for use with CPR Toolbox™ and CPR Flash™; USB 2.0 required 
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Overview 
 

Please take a moment to familiarize yourself with 
the device.  Notice that PSIClone™ is labeled with a 
letter ‘A’ on the left, and ‘B’ on the right.  
PSIClone™ permanently write-protects the ‘A’ side 
of the device.  This protects your ‘source’ drive by 
only allowing writes or erasures to happen on the 
‘B’ side of the device. 

PSIClone™ is controlled by five buttons, shown in 
Figure 2.  The red power button is used to power 
the unit on or off.  Upon turning the unit on, the 
LCD screen will display ‘CPR Tools – PSIClone’ and 
the version number. 
Using the four navigation buttons and the 16x2 
backlit LCD screen, a user can traverse the menu 
structure to instruct PSIClone™ to perform tasks.  
We will refer to these buttons as ‘UP’, ‘DOWN’, 
‘LEFT’ and ‘RIGHT’. 

PSIClone™ features two (2) PATA and two (2) SATA 
ports for Parallel ATA and Serial ATA drives.   
PSIClone™ is capable of safely powering no more 
than two (2) drives simultaneously, one on each 
side of PSIClone™ (Side A and Side B).  As an 
example you cannot place a drive on Side A PATA 
and Side A SATA and power them simultaneously. 

To ensure consistent and safe operation of 
PSIClone™, CPR Tools advises powering off 
PSIClone™ prior to attaching hard drives to either 
Side A or Side B.  Failure to do this may result in 
damage to your hard drives or void your 
PSIClone™ warranty. 

Figure 3 and Figure 4 offer a close-up, labeled view 
of ‘Side A’ and ‘Side B’ of PSIClone™.   

 

 
Figure 2 - PSIClone Navigation Buttons 

 

 
Figure 3 - PSIClone™, Side A 

 

 
Figure 4 - PSIClone™, Side B 

 

  

WARNING: 
Do NOT use a power splitter on any of 
the HDD power ports on either side A 
or B of the PSIClone™ device. 
The use of power splitters with 
PSIClone™ will void manufacturer’s 
warranty for the product and risks 
damaging PSIClone™ and attached 
drives. 
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Overview (continued) 
PSIClone™ Basics 
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Side A of PSIClone™ will serve as a connection 
point for ‘source’ drives only.  To preserve forensic 
integrity, no write operations are permitted to Side 
A.   

Conversely, Side B of PSIClone™ will serve as a 
connection point for ‘target’ or ‘destination’ drives.   

Only drives connected to Side B can be written to 
by PSIClone™.  

The PSIClone™ menu structure begins with eleven 
(11) top level menus.  Each of these will be discussed in detail.  The top level menus are: 

NOTE: Most PATA drives have 
‘master’, ‘slave’ and ‘cable select’ 
jumper positions printed on the drive 
container.  PATA drives must be set 
to ‘master’ to work consistently 
with PSIClone™. 

For WD drives which offer a jumper setting 
for ‘single’, this is optimal for working with 
CPR Tools’ devices. 

• Clone 
• Image 
• Format Drive 
• Compare 
• Bang 
• Identify 
• Reset 
• Drive Power 
• MD5 Hash 
• Error Handling 
• Options 

Using PSIClone™ with a PC 
System Requirements 
To use PSIClone™ with the CPR Toolbox™ or CPR Flash™ utilities, ensure that the host PC 
meets the minimum system requirements.  These are: 

1. Operating System: 
• Microsoft® Windows XP® SP2 
• Microsoft® Windows Vista® 
• Microsoft® Windows 7® 

2. USB 
• USB 2.0  



PSIClone™ User Interface 
PSIClone™ provides a 2 by 16 character LCD and 4 push navigation buttons, positioned in a 
diamond configuration: UP, DOWN, RIGHT and LEFT. When the unit is turned on the main menu 
is presented.  Users may make use of the UP and DOWN navigation buttons to scroll through 
menu items and/or options. To select an option, the RIGHT button is used.  LEFT button is used 
to cancel a selection or action, or to return to the previous menu. 

Additionally, the host companion software, CPR Toolbox™ (included with PSIClone™), may be 
used to control PSIClone™.  See the chapter titled ‘CPR Toolbox™’ for detailed information on 
using this utility with PSIClone™. 

 

 

 
 

 

 

 
 

Figure 5 - PSIClone™ - Navigation buttons 

In the menu map for PSIClone™ (Figure 6) and in subsequent ‘menu map’ snippets, an asterisk 
(*) is used to denote ‘active’ or ‘selected’ values. 
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|======================== 
|CLONE 
|--------FROM A PATA 
|--------|-----TO B PATA 
|--------|-----TO B SATA 
|--------FROM A SATA 
|--------|-----TO B PATA 
|--------|-----TO B SATA  
|======================== 
|IMAGE 
|--------FROM A PATA 
|--------|-----TO B PATA 
|--------|-----TO B SATA 
|--------FROM A SATA 
|--------|-----TO B PATA 
|--------|-----TO B SATA  
|======================== 
|FORMAT DRIVE 
|--------QUICK FORMAT 
|--------COMPLETE FORMAT 
|======================== 
|COMPARE 
|--------FROM A PATA 
|--------|-----TO B PATA 
|--------|-----TO B SATA 
|--------FROM A SATA 
|--------|-----TO B PATA 
|--------|-----TO B SATA 
|--------PATTERN  
|--------|-----<CHOICES> 
|--------|-----|-----TO B PATA 
|--------|-----|-----TO B SATA 
|--------INCREMENT 
|--------|-----TO B PATA 
|--------|-----TO B SATA 
|--------INVERSE BITS 
|--------|-----TO B PATA 
|--------|-----TO B SATA 
|======================== 
|BANG 
|--------B PATA 
|------------PATTERN 
|--------|-----<CHOICES> 
|------------INCREMENT 
|------------INVERSE BITS 
|------------RANDOM 
|--------B SATA 
|------------PATTERN 
|--------|-----<CHOICES> 
|------------INCREMENT 
|------------INVERSE BITS 
|------------RANDOM 
|======================== 
 

|======================== 
|IDENTIFY 
|--------A PATA 
|--------A SATA 
|--------B PATA 
|--------B SATA 
|======================== 
|RESET 
|--------A PATA 
|--------A SATA 
|--------B PATA 
|--------B SATA 
|======================== 
|DRIVE POWER 
|--------SIDE A 
|--------|-----TURN ON 
|--------|-----TURN OFF 
|--------SIDE B 
|--------|-----TURN ON 
|--------|-----TURN OFF 
|======================== 
|MD5 HASH 
|--------CALCULATE HASH 
|--------|-----A PATA 
|--------|-----A SATA 
|--------|-----B PATA 
|--------|-----B SATA 
|--------VIEW LAST HASH 
|======================== 
|ERROR HANDLING 
|--------STOP ON ERRORS 
|--------RECOVER ERRORS* 
|--------|-----JUMP SIZE ON ERR 
|--------|-----|-----<SELECT SIZE> 
|--------|-----PASS 2 T.O. CNT 
|--------|-----|-----<SELECT TIMEOUT> 
|--------|-----SOFTWARE RESET 
|--------|-----|-----TIMEOUT ERROR 
|--------|-----|-----ON DRIVE ERROR 
|--------|-----HARDWARE RESET 
|--------|-----|-----TIMEOUT ERROR 
|--------|-----|-----ON DRIVE ERROR 
|--------|-----POWER CYCLE 
|--------|-----|-----TIMEOUT ERROR 
|--------|-----|-----ON DRIVE ERROR 
|--------|-----NUMBER OF PASSES 
|--------|-----|-----1 PASS 
|--------|-----|-----2 PASSES* 
|======================== 

|======================== 
|OPTIONS 
|--------TRANSFER RATE 
|--------|-----AUTO* 
|--------|-----UDMA MODE 3 
|--------|-----UDMA MODE 2 
|--------|-----UDMA MODE 1 
|--------|-----UDMA MODE 0 
|--------|-----PIO 
|--------BACKLIGHT 
|--------|-----ON 
|--------|-----OFF 
|--------POWER DOWN 
|--------|-----AFTER COMPLETE 
|--------|-----LEAVE DRIVES ON* 
|--------POWER ON TIMEOUT 
|--------|-----<SELECT TIME IN MS> 
|--------COMMAND TIMEOUT 
|--------|-----<SELECT TIME IN MS> 
|--------FILE SIZE 
|--------|-----700 MB 
|--------|-----1 GB 
|--------|-----2 GB* 
|--------FILE NAME 
|--------|-----NAME:IMAGEBIN* 
|--------|-----|-----<CHOICE> 
|--------CMD. DIRECTION 
|--------|-----FORWARD* 
|--------|-----BACKWARD 
|--------BUZZER 
|--------|-----ENABLED 
|--------|-----DISABLED* 
|--------SESSION NUMBER 
|--------|-----DISPLAY SESSION 
|--------|-----RESET SESSION 
|--------COMPRESSION 
|--------|-----ENABLED 
|--------|-----DISABLED* 
|--------RESTORE DEFAULTS 
|======================== 

Figure 6 - PSIClone™ Menu Map 

(* indicates default value) 

  



 Example: Power on Timeout 
The following example is presented to illustrate entering and confirming a PSIClone™ value.  
The example uses the PSIClone™ ‘Power on Timeout’ setting; these techniques may be used for 
any item which permits user entry of a value. 

Where <SELECT TIME IN MS> is shown below, the user may select a value using the navigation 
buttons as described in the example titled “Power on Timeout”.  

Once a menu option is desired, use the RIGHT navigation button to select the option. Some 
menu options may have submenus. Once the user is faced with the final selection of a menu 
traversal, the RIGHT navigation button is used again to select and execute the function. 

When interacting with a PSIClone™ menu which requires you to select a numeric or 
hexadecimal value, remember to use the RIGHT navigation button to move to the rightmost 
position so that any choices will be accepted by PSIClone™.  When PSIClone™ accepts a value 
it will display ‘Configured’ on the LCD to confirm. 

‘Power on Timeout’ is part of the ‘Options’ menu tree. 

PSIClone™ Tips: 

The LEFT navigation button can be used at any time to back out a 
level of a menu.  

The LEFT navigation button can also be used to cancel a process 
that may be in progress. Depressing the LEFT navigation button 
during a process produces a ‘confirmation’ prompt.  If the user 
accepts this prompt, the process is terminated. 

PSIClone™ uses the LCD display to present much information to 
the user, not only about options to be selected, but also about the 
status of the operation. 

Menu Tree 

 

|======================== 
|OPTIONS 
|--------TRANSFER RATE 
|--------|-----AUTO* 
|--------|-----UDMA MODE 3 
|--------|-----UDMA MODE 2 
|--------|-----UDMA MODE 1 
|--------|-----UDMA MODE 0 
|--------|-----PIO 
|--------BACKLIGHT 
|--------|-----ON 
|--------|-----OFF 
|--------POWER DOWN 
|--------|-----AFTER COMPLETE 
|--------|-----LEAVE DRIVES ON* 
|--------POWER ON TIMEOUT 
|--------|-----<SELECT TIME IN MS> 
|--------COMMAND TIMEOUT 
|--------|-----<SELECT TIME IN MS> 
|--------FILE SIZE 
|--------|-----700 MB 
|--------|-----1 GB 
|--------|-----2 GB* 
|--------CMD. DIRECTION 
|--------|-----FORWARD* 
|--------|-----BACKWARD 
|--------BUZZER 
|--------|-----ENABLED 
|--------|-----DISABLED* 
|--------SESSION NUMBER 
|--------|-----DISPLAY SESSION 
|--------|-----RESET SESSION 
|--------COMPRESSION 
|--------|-----ENABLED 
|--------|-----DISABLED* 
|--------RESTORE DEFAULTS 
|======================== 
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PSIClone™ Functions 
The menu structure described in Figure 6 is meant to serve as a handy reference.  A more in-
depth discussion of each menu item available on your PSIClone™ is presented here. 

When scrolling through menus and submenus for which options may be selected, currently 
selected values are appended by an asterisk character (*). 

Clone 
Menu Tree 
|======================== 
|CLONE 
|--------FROM A PATA 
|--------|-----TO B PATA 
|--------|-----TO B SATA 
|--------FROM A SATA 
|--------|-----TO B PATA 
|--------|-----TO B SATA  
|======================== 
Default: N/A 
 

PSIClone™ defines a ‘clone’ as an exact sector-by-sector copy.   

Any drive connected to ’Side A’ can be cloned to a drive connected to ‘Side B’.  PSIClone™ uses 
the maximum transfer mode supported for the drives unless a different transfer rate was 
specifically chosen by the user.  Users may select alternate transfer rates in the Options menu.  
If the user selects a transfer rate that is not supported by either of the attached drives 
PSIClone™ will automatically adjust the rate to the maximum rate supported by both drives.  

In order to clone the drive as quickly as possible, PSIClone™ uses an advanced error handling 
algorithm which is divided into two passes.  The first pass clones all error free sectors and 
identifies and reports all problem areas.  The second pass revisits problem areas and extracts 
each sector of readable data and clones them to the destination.  More information can be 
found on error handling later in this manual. 

 

  
Example: 

Drive A (source) supports up to UDMA 3 and Drive B (destination) supports PIO only; 
PSIClone™ will automatically adjust to PIO Mode. 

In order to perform a sector-by-sector clone, the destination drive must be at least the 
same size or larger than the source drive and must be free of errors. All sectors of the 
source drive will be copied to the destination until the last source sector is transferred. 

To ensure data integrity and to be certain the destination drive is free of write errors, 
CPR Tools recommends running the PSIClone™ Bang function on any drive intended to 
be the destination of a cloning operation; after a successful Bang function has been 
completed, it is recommended the user run the Compare function against the bang 
pattern written to the drive.  
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Image 
Menu Tree 
|======================== 
|IMAGE 
|--------FROM A PATA 
|--------|-----TO B PATA 
|--------|-----TO B SATA 
|--------FROM A SATA 
|--------|-----TO B PATA 
|--------|-----TO B SATA 
|======================== 

Default: N/A 
A drive image is a file or set of files which represent the source drive, including any 
filesystem(s) thereon.  Imaging utilities vary in their implementations, but all result in a file or 
set of files (fileset) which can be restored to create a copy 
of the source drive’s data.  If an image consists of more 
than one file, each component file in the fileset is called an 
‘image segment’.  PSIClone™ creates filesets which are 
comprised of segment files each of which may be 700 MB, 
1 GB or 2GB.  

Note: 
The 700 MB option is provided to 
facilitate copying of image files to 
CD media. 

The size of segment files is user-defined and is configurable under the Options/File Size menu. 
By default, this value is set to 2GB.  

Creating a drive image with PSIClone™ 
1. Attach the source drive to Side A of PSIClone™.  Ensure that the storage capacity of the 

destination drive is larger than that of the source.  Attach the destination drive to Side B 
of PSIClone™. 

a. The destination drive must be formatted by PSIClone™; use the ‘Format Drive’ 
command to prepare the destination drive to receive the image fileset. 

i. The ‘Format Drive’ command is available under the ‘Options’ menu. 
2. Set or change the size of each segment of the drive image fileset by using the 

PSIClone™ menus.  PSIClone™ performs formats using the FAT32 filesystem.   
a. The ‘File Size’ setting is located under ‘Options’ 

3. Navigate to the Image menu. 
4. Select source drive location (A PATA or A SATA) 
5. Select destination drive location (B PATA or B SATA) 
6. Press the right navigation button to initiate the Image process. 

PSIClone™ Image Filesets 

 

     Page 17 of 141 

PSIClone™ User’s Guide 

 

Filesets generated by the PSIClone™ image function are 
stored on the destination drive.  For each drive image 
session a directory is created on the destination drive in 
the format ‘Dirxxxxx’ where xxxxx represents an 
incrementing number, beginning with 000. 

Within each fileset folder, fileset segments (individual 
files) are created and named in the format “Imagebin.xxx” where xxx represents an 
incrementing number beginning with 001. 

Note: 
PSIClone™ now permits user-
defined filenames for image 
filesets.  Manage image fileset 
names under Options/File 
Name in the PSIClone™ menus. 

PSIClone™ image filesets are written to industry standards; reassembly of PSIClone™ image 
filesets is able to be accomplished through the use of industry standard tools including the 
XCOPY command included with most DOS-like operating systems (if using MS-DOS XCOPY.EXE 
or others like it, be sure to use the /b flag which instructs the utility to assume ‘binary’ type 
files). 

  



Cancelling and Resuming an Image 
The imaging process may be interrupted and resumed at a later time.  If an imaging process 
has been cancelled (by pressing the LEFT navigation button) and is re-initiated, PSIClone™ 
identifies the existing image files and offers to resume the process. 

If an image has been cancelled and is re-initiated, the LCD displays: 

 
Pressing the RIGHT navigation button will instruct PSIClone™ to resume the imaging process 
from the point it was previously interrupted.  Pressing the LEFT navigation button will instruct 
PSIClone™ to ignore the existing fileset and begin a fresh image fileset. 

Restoring From An Image Fileset Which Was Cancelled And Resumed 
Reconstructing data from an image fileset which was cancelled and resumed at a later date is 
made possible through information contained in the imaging logs which PSIClone™ writes to the 
destination drive. 
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As previously discussed, upon initiation of an 
image fileset, a directory is created in the 
format DIRxxxxx where xxxxx is an 
incrementing number starting with 00000.  
The actual image filesets are written to these 
folders; PSIClone™ also writes a log file 
(LOG_FILE.txt) in plain text which provides 
an audit trail of each imaging process. 

When working with image filesets which have 
been resumed, the section of the log file 
labeled Results contains important 
information which will be required if an image 
is to be stitched together from the fileset 
segments within each DIRxxxxx.  The 
example below depicts the Results section 
from two image fileset log files.  The first is from an initial image which was interrupted.  The 
second is from the resumption of the first image and the completion of the image fileset. 

PSIClone Tips: 

When PSIClone™ resumes a previously cancelled 
image a new incrementally numbered directory is 
created.  The Imagebin.xxx files written are 
continued in the folder created when the image 
process is resumed. 

Example: A user initiates the creation of an image 
fileset.  PSIClone™ creates DIR00000 on the target 
drive and creates Imagbin.001 through 
Imagebin.006 at which point the image process is 
cancelled.  When the image is resumed, PSIClone™ 
creates DIR00001 on the target drive and resumes 
the numbering of the Imagebin.xxx files, starting 
from Imagebin.007. 

  
Initial Image – Cancelled Resumed from Initial Image 

Results 
-------------- 
Directory: DIR00001 
Error LBA, Status, Pass: 
 
Total Errors: 0000000000 
Operation Status: Cancelled 
Number of Files: 0000000001 
First LBA Imaged: 0000000000 
Last LBA Imaged: 0003763199 
MD5 Hash: N/A 
 
End Date: 09/18/08 
End Time: 15:00 

Results 
-------------- 
Directory: DIR00002 
Error LBA, Status, Pass: 
 
Total Errors: 0000000000 
Operation Status: Resumed From DIR00001 
Number of Files: 0000000004 
First LBA Imaged: 0003763200 
Last LBA Imaged: 0019541087 
MD5 Hash: N/A 
 
End Date: 09/18/08 
End Time: 15:06 

Using the information in this section of the resulting log files, the user may determine what files 
are required to restore from a series of image filesets.  As there are no filename conflicts within 
cancelled/resumed image filesets, the contents of the folders may be merged to facilitate 
restoring of the image.  



Format Drive 
Menu Tree 
|======================== 
|FORMAT DRIVE 
|--------QUICK FORMAT 
|--------COMPLETE FORMAT 
|======================== 

Default: N/A 
 

The ‘Format Drive’ function will format a drive connected to Side B.  Users may select Quick or 
Complete Format from the options provided.  Selecting ‘Complete Format’ will cause PSIClone™ 
to first write a pattern of 00 to each sector of the drive before applying a FAT32 file system.   

Compare 
Menu Tree  
|======================== 
|COMPARE 
|--------FROM A PATA 
|--------|-----TO B PATA 
|--------|-----TO B SATA 
|--------FROM A SATA 
|--------|-----TO B PATA 
|--------|-----TO B SATA 
|--------PATTERN  
|--------|-----<CHOICES> 
|--------|-----|-----TO B PATA 
|--------|-----|-----TO B SATA 
|--------INCREMENT 
|--------|-----TO B PATA 
|--------|-----TO B SATA 
|--------INVERSE BITS 
|--------|-----TO B PATA 
|--------|-----TO B SATA 
|======================== 

 

Default: N/A  

PSIClone™ Tips: 
 
PSIClone™ performs compare operations on a 
‘byte-by-byte’ basis. 

 

 

The compare command is used to: 

1. Compare a drive attached to Side A of the PSIClone™ to a drive attached to Side B of 
the PSIClone.  This is used for validating the results of a clone. 

2. Compare a drive to any ‘bang’ pattern (other than random).  This is used to validate 
that the selected pattern was written. 
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Bang 
Menu Tree 
|======================== 
|BANG 
|--------B SATA 
|------------PATTERN 
|--------|-----<CHOICES> 
|------------INCREMENT 
|------------INVERSE BITS 
|------------RANDOM 
|--------B PATA 
|------------PATTERN 
|--------|-----<CHOICES> 
|------------INCREMENT 
|------------INVERSE BITS 
|------------RANDOM 
|======================== 

Default: N/A 
 
This erases all user-addressable sectors, writing one of many different patterns to the drive: 

• Pattern – The user can select any hexadecimal byte pattern to be used in the process. 
• Increment – An incrementing word pattern is used for each word written to the device. 

The pattern repeats after 65536 words as it rolls over from FFFFh to 0000h. 
• Inverse Bit – Writes an inverting bit pattern to consecutive locations on the drive. 
• Random – A new 16 bit random number is generated for each word location. 

 

Identify 
Menu Tree 
|======================== 
|IDENTIFY 
|--------A PATA 
|--------A SATA 
|--------B PATA 
|--------B SATA 
|======================== 

Default: N/A 
 
Selecting ‘Identify’ executes the ATA Identify Device command. If a drive is connected and 
responds to the command, the following data will be displayed on the LCD: 

• Model Name 
• Serial Number 
• Firmware Revision 
• ATA Specification Version Supported 
• Maximum UDMA Mode 
• Maximum PIO Mode 
• Maximum LBA 

Use the UP and DOWN navigation buttons to scroll through the returned results. 

 

  



Reset 
Menu Tree 
|======================== 
|RESET 
|--------A PATA 
|--------A SATA 
|--------B PATA 
|--------B SATA 
|======================== 

Default: N/A 

Selecting ‘Reset’ performs a hardware reset on the selected drive. This function does not 
execute any ATA commands. 
 

Drive Power 
Menu Tree 
|======================== 
|DRIVE POWER 
|--------SIDE A 
|--------|-----TURN ON 
|--------|-----TURN OFF 
|--------SIDE B 
|--------|-----TURN ON 
|--------|-----TURN OFF 
|======================== 

Default: N/A 

PSIClone™ controls the power applied to any attached drives.  By using this function, the user 
may power up or power down drives connected to either ‘Side’ of the PSIClone™. 

If the user initiates a PSIClone™ function which requires attached drive(s) to be powered, 
PSIClone™ will automatically initiate ‘power on’ sequences to each of the required drives.  

 
NOTE: 
PSIClone™ is capable of safely powering no more than 
two (2) drives simultaneously, one on each side of 
PSIClone™ (Side A and Side B).  As an example you 
cannot place a drive on Side A PATA and Side A SATA 
and power them simultaneously. 
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MD5 Hash 
Menu Tree 
|======================== 
|MD5 HASH 
|--------CALCULATE HASH 
|--------|-----A PATA 
|--------|-----A SATA 
|--------|-----B PATA 
|--------|-----B SATA 
|--------VIEW LAST HASH 
|======================== 

Default: N/A 
PSIClone™ is able to calculate an MD5 hash for any attached drive.  Unlike other handheld 
devices, ‘on the fly’ generation of an MD5 hash for any attached drive does not affect 
PSIClone™ performance and will not impact the time to complete an operation.  The 
‘View Last Hash’ submenu item may be used to display the last hash calculated by PSIClone™.  
Once calculated, the MD5 hash may be displayed by navigating to the ‘View Last Hash’ menu. 

Error Handling 
Menu Tree 
|======================== 
|ERROR HANDLING 
|--------STOP ON ERRORS 
|--------RECOVER ERRORS* 
|--------|-----JUMP SIZE ON ERR 
|--------|-----|-----<SELECT SIZE> 
|--------|-----PASS 2 T.O. CNT 
|--------|-----|-----<SELECT TIMEOUT> 
|--------|-----SOFTWARE RESET 
|--------|-----|-----TIMEOUT ERROR 
|--------|-----|-----ON DRIVE ERROR 
|--------|-----HARDWARE RESET 
|--------|-----|-----TIMEOUT ERROR 
|--------|-----|-----ON DRIVE ERROR 
|--------|-----POWER CYCLE 
|--------|-----|-----TIMEOUT ERROR 
|--------|-----|-----ON DRIVE ERROR 
|--------|-----NUMBER OF PASSES 
|--------|-----|-----1 PASS 
|--------|-----|-----2 PASSES* 
|======================== 

Default: Recover Errors 
 
Stop On Errors  
Selecting this option will cause PSIClone™ to terminate a command upon encountering an 
error.  A ‘FAILED’ message, as well as the LBA attempted when the error occurred, is displayed 
on the PSIClone™ LCD screen. 

Recover Errors [default] 
Users may configure how PSIClone™ reacts to errors it may encounter when reading from or 
writing to a hard drive.   

 
PSIClone™ Tips:   

In order to take full advantage of the Error Handling features built into PSIClone™, 
CPR Tools recommends a thorough review of each of the submenu options within 
Error Handling.  These submenu options work intimately with one another.   
Modifications within the submenus of the Error Handling structure may affect the 
results obtained. 
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Recover Errors Options 
PSIClone™ may be configured to ‘Recover Errors’.  This setting instructs PSIClone™ to flag the 
sector in which the error was encountered and to continue with the clone process.  Upon 
completion of the first pass, PSIClone™ will automatically attempt to clone the flagged sectors, 
one at a time. 

In general, two types of errors may occur: 

1. Timeout Error 
o A Timeout Error is generated by PSIClone™ when a reply to an issued command 

is not returned within the established time threshold. 
2. Drive Error 

o Drive errors are those that PSIClone™ receives from an attached device in 
response to a command.   

PSIClone™ handles each of these errors similarly; the difference is the order in which certain 
steps are taken. 

PSIClone™ can be configured to perform any, all or none of the following steps when a Timeout 
Error is generated.  The steps are executed in the order listed: 

1. Power Cycle 
2. Hardware Reset 
3. Software Reset 

PSIClone™ can be configured to perform any, all or none of the following steps when a Drive 
Error is generated.  The steps are executed in the order listed: 

1. Software Reset 
2. Hardware Reset 
3. Power Cycle 

The ‘Recover Errors’ submenu contains options which allow the user to customize the behavior 
of the PSIClone™: 

• Jump Size On Error 
• Pass 2 T.O. Cnt 
• Software Reset 
• Hardware Reset 
• Power Cycle 
• Number of Passes 

Each of the ‘Recover Errors’ sub-options are discussed below. 
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Jump Size On Error 
Default: 256 LBAs 

The value set for Jump Size On Error is used when PSIClone™ encounters a Drive or 
Timeout Error on the first pass.   

If PSIClone™ encounters an error from a device on first pass, it flags the sector for later 
review and proceeds after jumping ahead by this value.  The user may change this 
decimal value by positioning the cursor under each of the ten (10) digits in turn; once 
positioned, the UP and DOWN buttons will increment or decrement the value for that 
digit.  Valid values range from 1 to 4,294,967,295. 

Pass 2 T.O. Cnt (Pass 2 timeout count) 
Default: 5,000ms (5 seconds) 

The value set here will define how long PSIClone™ is configured to wait for a device to 
recover from an error and return to ‘ready’ state.  This value affects the second pass 
only, as the ‘Command Timeout’ setting defines the wait time for pass one.   

Software Reset 
Default: None 

This option, when selected, performs a ‘software reset’ on the drive from which an error 
has been reported. 

Software Reset may be selected to occur in the case of timeout errors, drive errors, both 
timeout and drive errors or neither timeout nor drive errors. 

Hardware Reset 
Default: Timeout Error/Drive Error (both) 

This option, when selected, performs a ‘hardware reset’ on the drive from which an error 
has been reported. 

Hardware Reset may be selected to occur in the case of timeout errors, drive errors, 
both timeout and drive errors or neither timeout nor drive errors.  

Power Cycle 
Default: None 

This option, when selected, performs a ‘power cycle’ on the drive from which an error 
has been reported. 

Power Cycle may be selected to occur in the case of: 

• Timeout Errors 
• Drive Errors 
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Options 
Menu Tree 
|======================== 
|OPTIONS 
|--------TRANSFER RATE 
|--------|-----AUTO* 
|--------|-----UDMA MODE 3 
|--------|-----UDMA MODE 2 
|--------|-----UDMA MODE 1 
|--------|-----UDMA MODE 0 
|--------|-----PIO 
|--------BACKLIGHT 
|--------|-----ON 
|--------|-----OFF 
|--------POWER DOWN 
|--------|-----AFTER COMPLETE 
|--------|-----LEAVE DRIVES ON* 
|--------POWER ON TIMEOUT 
|--------|-----<SELECT TIME IN MS> 
|--------COMMAND TIMEOUT 
|--------|-----<SELECT TIME IN MS> 
|--------FILE SIZE 
|--------|-----700 MB 
|--------|-----1 GB 
|--------|-----2 GB* 
|--------FILE NAME 
|--------|-----NAME:IMAGEBIN* 
|--------|-----|-----<CHOICE> 
|--------CMD. DIRECTION 
|--------|-----FORWARD* 
|--------|-----BACKWARD 
|--------BUZZER 
|--------|-----ENABLED 
|--------|-----DISABLED* 
|--------SESSION NUMBER 
|--------|-----DISPLAY SESSION 
|--------|-----RESET SESSION 
|--------COMPRESSION 
|--------|-----ENABLED 
|--------|-----DISABLED* 
|--------RESTORE DEFAULTS 
|======================== 

Default: See individual listings below 
The user may set options that will aid in the use of PSIClone™.  User selected parameters 
within the Options menu are stored in non-volatile memory and may be reset to factory 
defaults using the ‘Restore Defaults’ submenu item, if desired. 

 

 

  



PSIClone™ Options Submenus 

Transfer Rate 
Default: Auto 

Transfer rate set to the default, ‘Auto’, allows PSIClone™ to use the most efficient 
transfer rate for the attached drives.   

Select a maximum transfer rate from the available choices: ‘UDMA Mode 3’, ‘UDMA Mode 
2’, ‘UDMA Mode 1’, ‘UDMA Mode 0’, ‘PIO’.  By setting this value to anything other than 
‘auto’, the user is setting an upper limit for transfers.  This option is made available to 
users in the event the user must force a drive to use a lower transfer rate. 

Backlight 
Default: On 

This setting allows the user to toggle the backlight of the LCD display. 

Power Down 
Default: ‘Leave drives on’ 

This setting allows the user to toggle the behavior of PSIClone™ after a clone or Bang 
has completed.  Select from ‘Leave drives on’ (drives continue to be powered on after 
the function has completed) or ‘After Complete’ (drives are powered off after the 
function has completed). 

Power On Timeout 
Default: 20,000ms (20 seconds) 

This value defines the maximum time PSIClone™ will wait for a drive to come ready on 
power-up.  While this value is typically sufficient for healthy drives, users may wish to 
increase this value for drives with errors.  

This does not mean that every power-up sequence will take the full Power on Timeout 
period, as PSIClone™ will continue as soon as a drive comes ready. 

Command Timeout 
Default: 4,000ms (4 seconds) 

This value represents the amount of time PSIClone™ will wait for a reply after issuing a 
command.  Replies from devices which exceed this value will be considered to have 
‘timed-out’. 

File Size  
Default: 2GB 

The value set here is used in conjunction with 
the imaging function included with PSIClone™.  
The available values are 700 MB, 1 GB and 
2GB; the size chosen will define the size of 
drive image file segments output by 
PSIClone™.   

PSIClone Tips: PSIClone™ 
supports 700MB file segments to 
enable transfer of image segment 
files to CD media 

File Name 
Default: IMAGEBIN 

User’s may customize the base filename for image file segments.  Use the UP and DOWN 
navigation keys at each letter position to cycle through letters A through Z and 0 
through 9 to create an 8 character custom filename, if desired. When the custom name 
has been entered, press the RIGHT navigation button. PSIClone™ responds with 
CONFIGURED to indicate that the new name has been stored. 
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Cmd Direction 
Default: Forward 

The Cmd Direction (Command direction) setting provides PSIClone™ with instructions to 
perform commands either, forward or backward. 
Note: Backward direction is available for BANG or CLONE operations only. 

Buzzer 
Default: Disabled 

Enabling this option will cause PSIClone™ to sound an audible alert upon completion of 
an action. 

Session Number 
Default: Not Applicable 

Selecting ‘Display Session’ causes PSIClone™ to display the current session ID.   

Selecting ‘Reset Session’ from within this submenu will cause PSIClone™ to clear all logs 
from the integrated flash memory and reset the numbering scheme for the creation of 
image filesets and the directories in which they reside. 

Compression 
Default: Disabled 

Set this to ‘Enabled’ to instruct PSIClone™ to employ a compression algorithm when 
creating an image fileset.   

Restore Defaults 
Default: Not applicable 

Users may globally reset all PSIClone™ options to their factory defaults by navigating to 
this item and pressing the RIGHT navigation button.  PSIClone™ responds with 
‘Configured’ when settings have been reset to factory defaults. 

  



Software: 
CPR Tools Utilities Suite 
The CPR Tools Utilities Suite is a collection of software designed to work with Hammer™, 
PSIClone™, SCSI Hammer™ and other CPR Tools devices.  The CPR Tools Utilities Suite 
includes: 

CPR Toolbox™  
• Host utility  

CPR Tools Flash Utility + USB Driver 
• Software to update firmware  
• CPR Tools USB Driver  

Firmware 
• Latest firmware  

Documentation 
NOTE: 
When available, updates to software, 
firmware and documentation may be 
downloaded from 
http://www.cprtools.net/downloads. 

• Release Notes 
• User Guides 
• Specification Sheets 

 
 

The next section of this guide will review installation of the CPR Tools Utilities Suite and use of 
the host companion software, CPR Toolbox™. 

  
IMPORTANT:  
When upgrading CPR Tools Utilities Suite™ from a previous version, users may be 
required to upgrade the firmware on PSIClone™ to ensure functionality with the 
new version.    

The CPR Flash™ utility and new firmware files are included with each CPR Tools 
Utilities Suite™ release. 
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Working with a Windows XP®, Windows Vista® or Windows 7® Host 
The CPR Utilities Suite is a collection of applications designed 
to run on Microsoft® Windows XP® SP2, Windows Vista® and 
Windows 7® Operating Systems.  PSIClone™ may be 
connected to a Windows host computer by USB, using the 
cable provided.  CPR Toolbox™ not only provides a familiar 
user interface with which PSIClone™ may be used, it offers 
extended functionality. 

NOTE: 
CPR Tools host utilities interact 
with PSIClone™ via USB 2.0 
connections only. 

 

Installing CPR Utilities Suite 
The CPR Tools Utilities Suite is included on the CD which 
was shipped with PSIClone™.  Install the software by 
inserting the CD into the host system.  The CPR Tools 
Utilities Suite installer is packaged as a self-extracting 
archive. 

NOTE: 
The latest updates for the CPR Tools 
Utilities Suite including CPR 
Toolbox™ are always available at 
the CPR Tools download page: 
http://downloads.cprtools.net/.  Double click the file ‘CPR Tools Utilities Suite.EXE’ to 

begin the installation process.  The install process is 
guided by the CPR Tools Utilities Suite Setup Wizard. 

 

 
Figure 7 - CPR Tools Utilities Suite Setup Wizard 

 

Click ‘Next’ to continue. 
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The ‘License Agreement’ screen which follows, is shown in Figure 8. 

 

 
Figure 8 - License Agreement 

 

The destination of the installation is user configurable.  Users may select the default location or 
specify a path on the host. 

 

 
Figure 9 - Select Destination Location 
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By default, the program will install to the system drive (typically ‘C:’) under ‘Program Files\CPR 
Tools\CPR Tools Utilities Suite\’.  To install to the default location, click ‘Next’.  

Users may select a complete installation or customize the installation of CPR Tools Utilities 
Suite.  Figure 10 depicts the ‘Select Components’ dialog box which allows for customizing the 
installation of components.   

In this view, ‘Full Installation’ is selected and shown in the drop-down list at the top of the 
dialog box.  Users may deselect any undesired components by clicking the checkbox beside the 
listed component.  As CPR Utilities Suite contains documentation, firmware and support files for 
PSIClone™, Hammer™ and SCSI Hammer™, ‘Full Installation’ includes firmware and 
documentation for both PSIClone™, Hammer™ and SCSI Hammer™.   

Users may choose to install only files relating to PSIClone™ by selecting ‘PSIClone Installation’ 
from the drop-down list provided. 
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Figure 10 - Full Installation - All items are installed 

 
After selecting desired components, click ‘Next’. 
 
  



The ‘Select Start Menu Folder’ dialog is presented. The default entry will cause a folder named 
‘CPR Tools’ to appear under ‘Start/Programs’.  Within this folder, users will have access to all 
components selected.  If no start menu folder is desired, check the box marked ‘Don’t Create a 
Startup Folder’. 

 
Figure 11 - Selecting a Start Menu Folder 

Click ‘Next’. 
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The ‘Select Additional Tasks’ dialog is presented which offers users the ability to create Desktop 
and Quick Launch shortcuts for selected components.  Items marked with a checkmark will 
generate Desktop and Quick Launch icons; deselect any item for which neither Desktop nor 
Quick Launch icons are desired. 

 
Figure 12 - Select Additional Tasks 

Click ‘Next’. 
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The ‘Ready to Install’ dialog box is presented to confirm all selected components.  To change 
which components are to be installed, click ‘Back’.   

 
Figure 13 - Ready To Install 

To proceed with installing the selected components, click ‘Install’.  

Installation progress is provided as shown in Figure 14. 
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Figure 14 - Installation progress  



The default settings for the installer will cause the ‘Windows Logo Testing’ dialog box to appear. 

 
Figure 15 - Windows Logo Testing dialog box. 

Click 'Continue Anyway' if this is shown. 

Users must click ‘Continue Anyway’ for the required USB driver to be installed. 
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When the installer has completed, a confirmation message is displayed. 

 
Figure 16 - Installation Complete 

To exit the installer, click ‘Finish’.  If the ‘Launch CPR Toolbox 2010’ box is checked, CPR 
Toolbox™ will launch; if the ‘Browse Documentation’ box is checked, a Windows Explorer 
window will open to the folder into which documentation was installed.  The documentation 
subfolder contains useful information, including Release Notes, Spec Sheets and User Guides.   

The Release Notes folder provides helpful information about PSIClone™ as well as the 
applications installed by CPR Tools Utilities Suite installer, including CPR Flash™ and CPR 
Toolbox™. 

The Spec Sheets folder includes product specifications for PSIClone™, Hammer™ and SCSI 
Hammer™. 

The User Guides folder contains PDF versions of user guides for PSIClone™, Hammer™ and 
SCSI Hammer™. 
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Connecting PSIClone™ to a Host Computer (USB 2.0 required) 
After installing CPR Tools Utilities Suite, connect PSIClone™ to the host system via the USB 
cable provided. 

When the ‘Found New Hardware’ wizard appears, select the radio button labeled ‘No, not this 
time’. 

 
 

Click ‘Next’ 
  

 

     Page 37 of 141 

PSIClone™ User’s Guide 

 



Select the radio button labeled ‘Install the software automatically (Recommended). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click ‘Next’. 
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An alert dialog, shown here, may appear.  To continue with driver installation, click ‘Continue 
Anyway’. 
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When the PSIClone™ driver has been installed, Windows will present the ‘Completing the Found 
New Hardware’ dialog box.  Exit the wizard by clicking ‘Finish’. 
 

 
 
The host system has been successfully prepared for use with PSIClone™ and CPR Toolbox™. 
  



Launching CPR Toolbox™ 
If CPR Toolbox™ was installed using 
default installer settings, the program 
may be launched from the Windows 
Start menu, under Programs/CPR 
Tools/CPR Tools Utilities Suite/CPR 
Toolbox 2010.  The application will 
discover any CPR Tools’ devices 
(PSIClone™, Hammer™, SCSI Hammer™ 
etc…) which are powered and connected 
to the host system.  The image below 
shows the initial screen when CPR 
Toolbox™ is launched with a PSIClone™ 
powered and attached to the host PC. 

 
 

 

 

 

 Figure 17 -  CPR Toolbox™, Initial Screen 

 

NOTE:  
Upon clicking the icon for the attached PSIClone™, CPR Toolbox™ will open the ‘Control Panel’ for the 
selected device.  This setting may be overridden in the ‘Device Options’ tab within ‘Control Panel’. 

This behavior may be changed by deselecting the checkbox under ‘Edit/Preferences 

CPR Toolbox™ displays three main panes of information, a toolbar and typical Windows pull-
down menus.   

1. The vertical pane at the left of the screen (Labeled ‘A’) lists CPR Tools’ devices and 
drives attached to CPR Tools’ devices. 

2. The pane at the right of the screen (Labeled ‘B’) is the main display window.  This will be 
populated, in tabbed format, as toolbar items are clicked. 

3. The lower, horizontal pane (Labeled ‘C’) displays output; i.e. logs, success/fail 
information, etc… 

The pull-down menu structure within CPR Toolbox™ is: 
File 
• Save Log 
• Print Log 
• Find in Log 
• Close 
• Exit 

Edit 
• Preferences 
• Sync Device Time 

View 
• Toolbars and Docking Windows  

o Standard 
o Output 
o Drive List 

• Status Bar 

Help 
• PSIClone Help 
• Hammer Help 
• SCSI Hammer Help 
• Debug Registers 
• Generate Tech Report 
• About CPR Toolbox 
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The ‘File’ menu: 

 

Clicking the ‘File’ menu reveals options displayed above.  ‘Save Log’, ‘Print Log’, ‘Close’ and 
‘Exit’ are presented as options. 

‘Save Log’ will save the output log to a file.  The user will be prompted for a location in which to 
save the file.  Alternately, the key combination CNTRL-S may be used to save the log to a file. 

‘Print Log’ will print the output log.  Alternately, the key combination CNTRL-P may be used to 
print the log. 

‘Find in Log…’ will present a search facility, enabling the user to search the log for specific 
search strings. 

‘Close’ becomes available when CPR Toolbox is displaying one or more tabs within its main 
window.  Clicking ‘Close’ will close the current tab. 

Clicking ‘Exit’ will close CPR Toolbox. 
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The ‘Edit’ Menu 

 
Clicking ‘Edit’ reveals two options.  Clicking the first, ‘Preferences’, presents the ‘Preferences’ 
dialog which is depicted in Figure 18.  
 
 

 
Figure 18 - CPR Toolbox™ Preferences 
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The Preferences box is divided into two (2) sections 
labeled General and Power Settings. 
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General 
This section contains options which define how CPR 
Toolbox™ will behave upon being launched.   
By clicking on each line in turn, a dropdown box will 
appear for the value at right. 
 
Perform initial device scan 
By default, CPR Toolbox™ will perform a scan for 
devices.  This may be changed selecting ‘No’ from the 
available dropdown box. 
Append to activity log 
By default, activity logs will be overwritten.  To 
change this behavior, set this value to ‘Yes’ 

Auto-launch control panel 
By default, CPR Toolbox will launch the ‘Control Panel’ 
whenever a device is selected.  Set this to ‘No’ to alter 
this behavior. 

Port Protect 
By default, no ports are protected from initial scans; 
CPR Toolbox™ will attempt to identify all attached drives when a CPR Tools device is powered.  
This setting allows for customization of this behavior.  
Available options are ‘Side A’, ‘Side B’, ‘Both’ or 
‘None’. 

Figure 19 - General Preferences 

Power Settings  
This section contains options which define how CPR 
Toolbox™ will handle power to ‘Sides’ of the attached 
CPR Tools device. 

On Initial Scan – Power On 
This setting controls which ‘Sides’ of the device will be 
powered on initial scan.  Available options are ‘Side A 
Only’, ‘Side B Only’, ‘Both Sides’ or the default, ‘None’. 

On Initial Scan - Power Off (if no drives found) 
This setting controls CPR Tools device behavior if a 
‘Side’ is powered during an initial scan but no drive(s) 
are found.  Available options are ‘Side A Only’, ‘Side B 
Only’, ‘None’ or the default, ‘Both Sides’. 

On Rescan – Power On 
This setting controls CPR Tools device behavior when 
performing a Rescan. Available options are ‘Side A 
Only’, ‘Side B Only’, ‘None’ or the default, ‘Both Sides’. 

On Rescan – Power Off (if no drives found) 
This setting controls CPR Tools device behavior if a 
‘Side’ is powered during a ‘Rescan’ but no drive(s) are found.  Available options are ‘Side A 
Only’, ‘Side B Only’, ‘None’ or the default, ‘Both Sides’. 

Figure 20 - Power Setting Preferences 

  



On Close (application shutdown – Power Off 
This setting controls how CPR Toolbox™ interacts with attached CPR Tools devices when the 
software is being closed.  Available options are ‘Side A Only’, ‘Side B Only’, ‘Both Sides’ or the 
default, ‘None’. 

For each of the selections in the Preferences dialog, 
descriptive text is displayed as a reminder of the 
functionality presented Figure 21.   

Several buttons appear at the bottom of the 
Preferences dialog.  Once selections have been made, 
the user may click ‘OK’ to apply settings and close the 
dialog box.  Clicking ‘Cancel’ will close the dialog 
without applying changes.  Clicking ‘Defaults’ will reload 
CPR Toolbox defaults.  Clicking ‘Apply’ will apply the 
user’s settings and will keep the Preferences dialog 
open. 

 

 

 

 

 
 
 
 
 Figure 21 - Text here describes the 

setting being changed above  
Sync Device Time 
The second option beneath the ‘Edit’ menu is ‘Sync Device Time’.  Use this option to update the 
selected CPR Tools device to your host system’s date and time.  When applied, CPR Toolbox™ 
presents a message box, depicted in Figure 22. 

 

 
Figure 22 - Successful synchronization of device time 
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The ‘View’ Menu 
 

The ‘View’ menu allows for customization of 
the CPR Toolbox™ user interface.  The top 
item, ‘Toolbars and Docking Windows’ 
provides three (3) sub-choices, all of which 
are selected by default.  The first, 
‘Standard’ allows the user to toggle display 

of the standard toolbar.   

The second item, will ‘Output’.  Deselect this item to hide the lower, horizontal pane.  This pane 
is labeled ‘C’ in Figure 17 which appears on 40 of this guide. 

The ‘Status Bar’ is displayed by default.  Deselect ‘Status Bar’ to hide this item. 

The ‘Help’ Menu 
Online help is available from within this menu by clicking ‘CPR Toolbox Help’.  The remaining 

options and their functions are: 
PSIClone™ / Hammer™ / SCSI Hammer™ /Sledge Hammer™ Help 
CPR Toolbox™ provides help files for PSIClone™, Hammer™, SCSI 
Hammer™ and Sledge Hammer™ devices.   
Debug Registers 
This option will open a ‘tab’ which displays debug registers for the 
selected device.  Use this when instructed to by CPR Tools technical 
support personnel. 
About CPR Toolbox 
Displays version information for CPR Toolbox™ and its components. 
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The CPR Toolbox™ Toolbar 
The CPR Toolbox™ software is easily controlled through the convenient button bar at the top of 
the main Toolbox window and is depicted in Figure 23. 

 
Figure 23 – The CPR Toolbox™ button bar 

The button bar displays ten (10) buttons, some of which have submenu selections available.  
The button bar menu structure is displayed here: 

• Rescan 
• Control Panel 
• Drive Info 

o Identify Drive 
o View S.M.A.R.T. 

• Drive Utilities 
o Sector Viewer 
o eDrive™ 
o gClone™ 
o gRase™ 

• Recover 
o Image Restore 
o Advanced Recovery 3 
o iFirmware™3 
o Mount/Unmount Drive 

• Security 
o Drive Key4 

• Reporting  
(sub tabs) 

o Jobs5 
o Certificates6 
o Print Labels6 
o Device Log5 
o Alert Settings 

• Save 
• Print 
• About 
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5 Used with Hammer™ and SCSI Hammer™ 

 



Rescan 
Clicking this toolbar button will cause the CPR Toolbox™ to rescan for CPR Tools 
devices (e.g. PSIClone™, Hammer™, SCSI Hammer™, etc…).  By default, 

rescanning for devices will power each side of PSIClone™.  This setting can be overridden, as 
shown in Figure 20 on page 43 of this guide. 
 

Control Panel 
Clicking this toolbar button will launch the Control Panel module.  The CPR 
Toolbox™ Control Panel module is an interface to many data security and data 

recovery functions.  The main window contains several sections, all worthy of discussion. 
 

Control Panel options are presented in tabbed format.  These include: 

• Image 
• Clone 
• Fast Clone 
• Bang 
• MD5 Hash 
• Format 
• Compare 
• HPA 
• DCO 
• Device Options 

 
Each of the Control Panel tabs provide specific capabilities and will be discussed in detail. 
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CPR Toolbox Control Panel 
Figure 21 depicts the initial view after clicking the ‘Control Panel’ icon.  The ‘Image’ tab is 
displayed. 

 
Figure 21 – Control Panel Initial Screen – CPR Toolbox 

Figure 22 depicts the top section of the Control Panel window. 

 

 
Figure 22 - Control Panel, Top Section – CPR Toolbox 

The top section of the control panel provides a visual representation of what drives are 
connected to PSIClone™ and provides a quick method for powering down a drive attached to 
PSIClone™.  The device power indicators, seen in ‘green’ may be used to toggle power to each 
side of the PSIClone™ device.  Simply click the icon to toggle power off (grey) or on (green).  

The left section describes drives connected to Side A, if any.  The right section describes drives 
connected to Side B, if any.    The drive interface, manufacturer, model, LBA count and capacity 
are displayed.   
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CPR Toolbox™ provides a color indicator for actions performed or completed.  The background 
colors for any drives connected to PSIClone™ will indicate the following: 

Color Definition 
Green Drive has completed an action without errors 
Red Drive has completed an action with errors 

White Drive is either idle or an action on this drive was cancelled by the user 
Yellow Drive is currently being acted upon; no errors have been encountered 

Red on Yellow Drive is currently being acted upon; errors have been encountered 
Figure 23 - CPR Toolbox Color Codes 

Figure 24 depicts a clone action.  Note PATA A (source) and PATA B (destination) are colored in 
yellow, indicating that these drives are participating in the current action. 

 
Figure 24  - CPR Toolbox™ color codes indicate current status 

The indicator boxes which appear beneath the Side A and Side B sections represent ATA status 
register activity when executing a command.  These indicators will light green or red, to 
indicate activity within the ATA status register.  The legend for these indicators is presented 
here: 

NOTE: 
All write functions are disabled to Side A of 
PSIClone™ device.   
This ‘write blocking’ feature is included to 
help limit the potential for inadvertently 
overwriting source data. 

• BSY - device busy                      
• DRDY - device ready                    
• DF/SE - device fault/stream error      
• DSC - drive seek complete              
• DRQ - data request                     
• CORR – error corrected                 
• IDX - index                            
• ERR - last command caused an error 

If an error is encountered, the default value of NA which appears under the ERR indicator will 
change to reflect, in hexadecimal format, the value of the ATA error register. 
Each bit in the ATA error register byte consists of a different error status. Multiple errors can be 
combined. Following is a description of each error status and its bit position in the ATA error 
register byte: 

• Bit 1 (lowest bit): Media Error/Command Timeout 
• Bit 2: No Media In Removable Device 
• Bit 3: Command Aborted 
• Bit 4: Media Change Request 
• Bit 5: LBA Address Not Found 
• Bit 6: Media Change Detected 
• Bit 7: ECC Error/Write Protected 
• Bit 8: CRC Error   
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Below this section of the Control Panel screen the user will find ten (10) tabs.  Each of these 
allows for specific drive tasks to be performed.   
The ten (10) tabs displayed will be discussed in detail.  They are: 

• Image 
• Clone 
• Fast Clone 
• Bang 
• MD5 Hash 
• Format 
• Compare 
• HPA 
• DCO 
• Device Options 

 
Image 
The Image tab provides the ability to create a complete disk image from a drive connected to 
Side A of the PSIClone™ to a drive connected to Side B of the PSIClone™ device. 

A disk image is a computer file or a group of computer files (known as an image fileset) 
containing the complete contents and structure of a data storage medium or device, such as a 
hard drive, CD or DVD. The term has been generalized to cover any such file, whether 
originated from an actual physical storage device or not. As such, a disk image contains all the 
information necessary to replicate the structure and layout, as well as the actual contents, of a 
storage device, and this is the distinguishing feature between an ordinary backup and a disk 
image. A disk image file or fileset is usually created based upon the sectors on the medium, 
ignoring its filing system. 

Note: 
The 700 MB option is provided to 
facilitate copying of image files 
to CD media. 

PSIClone™ and the CPR Toolbox™ create image filesets. 
The size of individual files within an image fileset is 
defined under the Settings tab of the CPR Toolbox™ and 
may be 700 MB, 1 GB or 2 GB.   
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The default file size for image files within a fileset is 2 GB.  This value may be changed on the 
Device Options tab. 

Figure 25 - The 'Image' Tab 
 

Creating an Image Fileset 
To create an image fileset, ensure that the destination drive (Side B) is of sufficient capacity to 
contain the image fileset which will be created from the data on Side A.  CPR Toolbox™ requires 
that the destination drive be formatted using CPR Toolbox.  If this is not done prior to initiating 
an image, CPR Toolbox™ will prompt the user to format the destination drive before continuing. 

Image Partition 
CPR Toolbox™ allows for the creation of image filesets from a partition on the source drive.  To 
enable this feature, check the box marked ‘Image Partition’ and select the partition from which 
the image fileset should be created from the dropdown list provided. 

Optional Compression 
PSIClone™ and CPR Toolbox™ provide the option to compress image filesets as they are 
created.  Use the PSIClone™ ‘Options/Compression’ submenu or the ‘Device Options’ tab in CPR 
Toolbox™ to enable compression.  This option is disabled by default. 
 

Image File Name 
New in this release of CPR 
Toolbox: User’s may now set 
custom filenames for image 
filesets. 

User’s may elect to change the output file name by 
modifying the text shown.  Filenames must not exceed 
eight (8) characters; an incremental, three digit extension 
will be added to the image files created, i.e. 
IMAGEBIN.000, IMAGEBIN.001, etc… 
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Once the source and destination drives have been attached to the PSIClone™ device, CPR 
Toolbox™ should display the attached drive information as shown in Figure 24.  The size of 
each individual file within the image fileset is defined in the Options tab of the Control Panel 
module of CPR Toolbox.   

Note:  
Imaging with PSIClone™ or other CPR devices (with or 
without CPR Toolbox™), requires that the destination drive 
be formatted using CPR Toolbox™ or a CPR device.  CPR 
Toolbox™ and devices format drives using the FAT32 
filesystem.  Other than CPR Toolbox™ or CPR device 
commands, the destination files system must NOT be 
modified. 

PSIClone™ will write files of the 
selected size to a folder on the 
destination drive named DIRxxxxx, 
where xxxxx is an incremental 
number beginning with 00001.  All 
files for the current image fileset will 
be written to this folder.  Files within 
an image fileset are named 
IMAGEBIN.xxx, or a custom name if 
one has been set by the user where xxx is an incremental number, beginning with 001. A log 
file of the imaging process, named LOG_FILE.txt, is also written to the fileset folder. 
If the destination drive has not been formatted by CPR Toolbox™ or PSIClone™, a message is 
displayed offering to perform a format. 

 NOTE: 
If the destination drive is not of 
sufficient size to receive the 
image, a message is displayed 
below the progress bar and 
PSIClone™ will display ‘Source 
larger than destination’ on the 
device LCD. 

 
 
 

 

 

 Figure 26 - Format Warning 
 

Drive formatting may also be performed using CPR Toolbox™ on the ‘Format’ tab. 

Once the destination drive has been formatted, click the ‘Image’ button to initiate creation of 
the image.   

 
 

 

 
 

 

 

 

Figure 27 - Messages displayed if destination drive is of insufficient size 
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Figure 28 displays CPR Toolbox™ during the process of creating an image fileset. 

 
Figure 28 - Imaging in progress 

 

 

During the Imaging process, a percentage complete is displayed in 
the drive list, at the left of the screen. 
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When the imaging process completes, CPR Toolbox™ alerts the user and provides an MD5 hash 
of the source.  If errors are encountered, an MD5 hash will not be calculated.  Errors will display 
in the output window (horizontal pane at the bottom of the CPR Toolbox™ main window). 

 
Figure 29 - Image Complete, CPR Toolbox™ displays MD5 Hash 

Cancelling and Resuming an Image 
As with PSIClone™ in stand-alone mode, 
CPR Toolbox™ allows for the resumption of 
previously cancelled image restoration.  If 
CPR Toolbox™ detects a resumable image 
fileset on the destination drive, a 
notification is displayed. 

Users should familiarize themselves with 
PSIClone™ image fileset naming conventions as described previously in this User’s Guide (Page 
18). 

Clicking ‘Yes’ will instruct CPR Toolbox™ and PSIClone™ to resume the imaging process from 
the point at which it was last cancelled.  Clicking ‘No’ will instruct CPR Toolbox™ and PSIClone™ 
to disregard the existing image fileset and to create a new image fileset. 
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Clone 
The Clone tab of the CPR Toolbox™ is used to create a sector-by-sector copy of a source drive 
attached to Side A of the PSIClone™ device to a destination drive attached to Side B of the 
PSIClone™ device. 
The Clone tab is shown in Figure 30. 

 
Figure 30 - The Clone Tab 

To initiate a clone: 

1. Select source drive on Side A of the PSIClone™ device. 

2. Ensure that start and end sectors are listed correctly 

3. Select destination drive on Side B 

4. Ensure that destination drive is of sufficient capacity 

a. If ‘Resize destination drive to match source range’ is selected, PSIClone™ will 
cause the destination drive to appear to have the same sector count as the 
source drive.  This is accomplished by establishing a Host Protected Area (HPA) 
on the destination drive. 

5. Click ‘Clone’ to begin a sector-by-sector copy of data from Side A to Side B 
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During the Clone process, a progress bar and text information is displayed to indicate cloning 
status. 

 
Figure 31 - Clone in progress 

 

When the clone process completes, CPR Toolbox™ displays an MD5 Hash.  Success or failure 
messages appear in the output window (horizontal pane at the bottom of the screen).  If errors 
are encountered, CPR Toolbox™ will not calculate an MD5 hash. If the command was run in 
reverse, CPR Toolbox™ will not calculate an MD5 hash.  

Figure 32 - Clone complete, MD5 Hash displayed 
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Fast Clone™ 
FastClone™ is a feature which allows for the copying existing file system(s) from one drive 
(Side A) to another (Side B).  Fast Clone copies only allocated sectors within a file system.  This 
method differs from conventional clones which typically perform sector-by-sector copies of an 
entire drive without regard for file systems or sector allocations. 

The FastClone™ tab is depicted in Figure 33. 

 
Figure 33 - FastClone™ tab 

Select a Source Drive (Side A) from the drop 
down list provided.  Next, select from the file 
systems discovered by PSIClone™.   
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Select ‘Clone Filesystem only’ or ‘Clone Entire 
Partition’ by clicking the corresponding radio 
button.  If ‘Clone Entire Partition’ is selected, 
users may choose to make a forensic copy by 
checking the box labeled ‘Forensic Copy’.   

Select a Destination Drive (Side B) from the 
drop down list provided.  The start and end 
sectors are calculated and displayed on 
screen.  To resize the destination drive to 
match the source range of sectors, check the 
box marked ‘Resize destination drive to match source range’.  Doing this will create an HPA on 
the destination drive. 

Forensic or Non-Forensic? 

If ‘Forensic Copy’ is checked, LBA 0 of the source 
drive is not copied.  Further, the clone will begin at 
LBA 0 of the destination drive and continue until all 
sectors in the source partition have been cloned.  
This type of clone will be viewable in a hex editor. 

If ‘Forensic Copy’ is NOT checked, LBA 0 is copied 
and the sector mapping of the source drive will be 
duplicated on the destination drive.  As LBA 0 will 
be copied, the partition table will be intact and 
should be viewable to a host operating system. 

Click the ‘Clone’ button to initiate the Fast Clone process.  A progress bar is displayed while the 
Fast Clone process is underway. 



Bang 
Bang is a term used to describe eradication of all data on a drive by overwriting each sector.  
PSIClone™ includes an embedded version of CPR Tools’ data eradication utility, BangDisk™.  
BangDisk™ complies with NIST 800-886 ‘clear’ specifications.   

Using the Bang function within the CPR Toolbox™, a user may eradicate all data on a drive 
connected to Side B of the PSIClone™ by overwriting every addressable sector on the drive. 

The Bang function allows the user to choose between several 
pattern types, including a custom type which may be defined 
by the user.  Pre-defined Bang types include ‘Random’, 
‘Incrementing’, ‘LBA Pattern’ and ‘Inverse Bits’.     
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Figure 34 displays the options available when the Bang tab 
of the CPR Toolbox™ Control Panel is in focus. 

 

NOTE: 
LBA Pattern is not available if the 
current settings call for the 
operation to be run in reverse. 

Figure 34 - The ‘Bang’ Tab 

To create a custom pattern, select ‘Custom’ from the Pattern Type drop down.  Select a value 
from the list; the selected value will be used to overwrite all sectors on the drive.  The ‘Custom 
Value’ dropdown is populated with a range of hexadecimal values beginning with 0x00 through 
0xFF.  

  

 
6 http://csrc.nist.gov/publications/nistpubs/800-88/NISTSP800-88_rev1.pdf 

http://csrc.nist.gov/publications/nistpubs/800-88/NISTSP800-88_rev1.pdf
http://csrc.nist.gov/publications/nistpubs/800-88/NISTSP800-88_rev1.pdf


Banging a Drive 
Once the source pattern has been selected, the user may initiate a Bang of the device by 
clicking the button labeled Bang. 

Bang progress is displayed in the form of text indicators and a progress bar.  Figure 35 shows 
the progress of a Bang. 

 
Figure 35 - Bang Progress 

 

CPR Toolbox™ will provide status of 
the completed Bang in the output 
window. 
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MD5 Hash 
Using the CPR Toolbox™ MD5 Hash tab, a user may calculate the MD5 Hash of a drive 
connected to either side of PSIClone™.  This function is useful subsequent to performing a 
Clone or having restored an Image fileset.   As the calculation of an MD5 Hash does not require 
write access to the drives, users may select drives on either Side A or Side B of the device. 

By calculating an MD5 Hash of a source drive and comparing that value to the MD5 Hash 
calculated on the destination clone or restored image, one may reasonably validate that an 
accurate clone or image was successfully created. 

To calculate an MD5 Hash, select a drive from the dropdown list and click ‘Calculate’. 

 
Figure 36 - Calculating an MD5 Hash 
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When complete, CPR Toolbox™ displays the calculated hash beneath the progress bar, as 
shown in Figure 37.   

 
Figure 37 - Completed MD5 Hash Calculation 

 

The calculated hash is displayed in the ‘output’ window (lower horizontal pane) as well as at the 
bottom of the MD5 Hash screen.   

To save this value for comparison, right-click in the output window and select ‘Save to File’. 
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Format 
NOTE:  
Imaging with PSIClone™ (with or 
without CPR Toolbox™), requires that 
the destination drive be formatted 
using CPR Toolbox™ or a CPR device.  
CPR Toolbox™ and devices format 
drives using the FAT32 filesystem.  
Other than CPR Toolbox™ or CPR 
device commands, the destination files 
system must NOT be modified. 

 

The Format tab provides the facility to perform 
a format on a drive connected to Side B of 
PSIClone™.  PSIClone™ performs formats using 
the FAT32 file system.   

Use this function prior to initiating an Image 
process using CPR Toolbox; should an Image 
be initiated prior to a Format of the destination 
drive being performed, CPR Toolbox™ will 
provide a dialog box offering to Format the 
destination drive before continuing.  PSIClone™ 
offers both ‘Quick’ and ‘Full’ format options.  
When formatting a drive using ‘Full Format’, PSIClone™ will first write 00 to each sector, 
effectively erasing all data on the drive; after the writing of 00 to each sector, the FAT32 file 
system will be applied. 
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Figure 38 - Use 'Format' prior to using ‘Image’ 

  

 

 

 

 

 

  



Compare 
The Compare tab of the CPR Toolbox™ is used to compare data from either a pre-defined 
pattern or source drive (Side A), to a drive on Side B of PSIClone™.  This function is used to 
verify the integrity of a Clone or Bang function.  Compare may be used to validate any 
PSIClone™/CPR Toolbox™ pattern, other than the 'Random Pattern. 

 
Figure 39 - Compare Pattern to Side B 

 

 
Figure 40 - Compare Side A to Side B 
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HPA (Host Protected Area) 
Host Protected Area, sometimes referred to as ‘Hidden’ Protected Area is an area of a hard 
drive that is not visible to an operating system. 
The HPA tab allows the user to adjust the Current Max setting of a drive attached to either Side 
A or Side B of PSIClone™.  The default capacity of a drive is equivalent to that drive’s ‘Native 
Max’.  Adjusting the Current Max value sets the drive to appear to be smaller than its default 
capacity. 

Figure 41 depicts the initial HPA Screen. 

 
Figure 41 - HPA Settings 

The right side of this screen shows the drive currently being examined and both the Current 
and Native Max settings for the drive.  If no HPA is present, these two values should be equal.   

To set an HPA, first select the radio button beside the New Current Max entry box, and enter a 
value to be applied as New Current Max.   Click the ‘Set HPA’ button to change the value for 
Current Max.   

Figure 42 depicts the success messages after an HPA has been created. 

 
Figure 42 – Setting an HPA 

 
Clearing an HPA will configure the drive to use the maximum addressable LBA range. 
To clear an existing HPA, select the ‘Clear Current HPA’ button.   

The ‘HPA’ section of the HPA tab keeps track of the last HPA value set.  This is done as a 
reference in the event the drive needs to be returned to the state it was in prior to being 
manipulated with CPR Toolbox™. 
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PSIClone™ Tips: 

Why use the DCO Tab? 

Often, in data recovery scenarios, a drive is 
received which may be limited by certain DCO 
settings. 

Using the editing ability provided within this tab, 
recovery technicians may save the initial (or 
subsequently changed) DCO status of the drive.   

Enabling or disabling features may aid in the data 
recovery effort.  The Save/Load functionality is 
provided to allow for ‘snapshots’ of DCO settings to 
be saved or quickly restored. 

DCO 
Device Configuration Overlay – The DCO 
tab provides a wealth of functionality, 
allowing the user to switch certain 
supported features on or off.   

Not all drives support DCO.  Figure 43 
depicts the DCO tab when a drive which 
does not support the DCO command set 
has been selected.  CPR Toolbox displays a 
message indicating the lack of DCO 
support for the selected drive.  
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Figure 43 - DCO not supported by drive on Side A 

  



Once a drive which supports DCO is selected, the user may proceed in working with DCO. 

 
Figure 44 - DCO Tab 

DCO Options may be toggled using this screen.  Only those 
options supported by the attached drives may be changed.  
Options not supported, such as ‘S.M.A.R.T Conveyance Self-
Test’ in Figure 44, are ‘grayed out’ and unavailable to the 
user. 

NOTE:  

The ability to edit or change ANY 
of the drive functions on this tab is 
wholly dependent upon support 
provided by the attached drive. DCO Options are presented using the drive’s current values.  

Each of the DCO options will be presented in detail. 

DCO Settings 
Current Max 
This setting allows the user to limit the size of the drive by specifying the number of LBAs which 
the drive will report.  This is similar to what may be performed using the HPA tab; it should be 
noted that an HPA may be set on a drive which has had its Current Max modified via DCO. 

This list defines which drive features are enabled or disabled when toggling available options: 

Security 
Enables/Disables support for the following commands:   

• SECURITY SET PASSWORD 
• SECURITY UNLOCK 
• SECURITY ERASE PREPARE 
• SECURITY ERASE UNIT 
• SECURITY FREEZE LOCK 
• SECURITY DISABLE PASSWORD 

Command set description: 
Allows user to lock and unlock drives and perform security erases. 

Advantages of disabling: 
Prevent inadvertent security erasing or locking of drive. 
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HPA Support 
Enables/Disables support for the following commands: 

• READ NATIVE MAX ADDRESS 
• READ NATIVE MAX ADDRESS EXT 
• SET NATIVE MAX ADDRESS 
• SET NATIVE MAX ADDRESS EXT 

 
Command set description: 
Allows user to reduce the reported size of a drive. 

Advantages of disabling: 
Prevents HPA from being set on a drive.  

 
48 Bit Support 
Enables/Disables support for the following commands: 

• FLUSH CACHE EXT 
• READ DMA EXT 
• READ DMA QUEUED EXT 
• READ MULTIPLE EXT 
• READ NATIVE MAX ADDRESS EXT 
• READ SECTOR(S) EXT 
• READ VERIFY SECTOR(S) EXT 
• SET MAX ADDRESS EXT 
• WRITE DMA EXT 
• WRITE DMA FUA EXT 
• WRITE DMA QUEUED EXT 
• WRITE DMA QUEUED FUA EXT 
• WRITE MULTIPLE EXT 
• WRITE MULTIPLE FUA EXT 
• WRITE SECTOR(S) EXT 

 
Command set description: 
These commands allow the user to read, write, and set HPAs on sectors above the 
28 bit mark (268435455). 

 
Force Unit Access:  
Enables/Disables support for the following commands: 

• WRITE DMA FUA EXT 
• WRITE DMA QUEUED FUA EXT 
• WRITE MULTIPLE FUA EXT 

 
Command set description: 
These commands force writes to bypass the write cache and instead write directly to 
the media.  These commands are used for data integrity purposes. 
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Streaming: 
Enables/Disables support for the following commands: 

• CONFIGURE STREAM 
• READ STREAM EXT 
• WRITE STREAM EXT 
• READ STREAM DMA EXT 
• WRITE STREAM DMA EXT 
• READ LOG EXT 
• WRITE LOG EXT 

 
Command set description: 
These commands are used to time critical data transfers as opposed to data integrity critical 
commands.  If the command doesn’t complete in the specified amount of time, the command 
fails. 

 
Automatic Acoustic Management: 
Enables/Disables support for Automatic Acoustic Management 
 

Command set description: 
Sets drive to operate at one of three levels:  

1. High noise and performance 
2. Medium noise and performance 
3. Low noise and performance 

 
Queued DMA: 
Enables/Disables support for queued I/O commands 
 

Command set description: 
Allows a host to issue concurrent commands to the same device.  The device will queue the 
concurrent commands, then process them.     

 
Multi-Word DMA: 
Sets the level of support for Multi-Word DMA support. 
 

Command set description: 
Multi-Word DMA is a method used to perform I/O operations in bursts.  Changing this value will 
change the default level at which the drive will perform these transfers. 

 
 
Ultra DMA: 
Sets the level of support for Ultra DMA transfers. 
  
Ultra DMA is a method used to perform I/O operations in bursts.  Changing this value will change the default 
level at which the drive will perform these transfers.  Ultra DMA transfers are faster than Multi-Word.   
 
Power Up In Standby: 
Enables/Disables the ability of a drive to power up in a standby power state. 
 

Command set description: 
“Allows  devices to be powered-up into the Standby power management state to minimize inrush 
current at power-up and to allow the host to sequence the spin-up of devices.  
Drive will spin up as soon as a command is sent that requires the drive to access the media.” 

 



 
S.M.A.R.T. Enable: 
Enables/Disables the S.M.A.R.T. system on the drive. 
 

Advantages of disabling: 
Drives that have problems with their S.M.A.R.T. system may perform better if 
S.M.A.R.T. is turned off. 

 
S.M.A.R.T. Error Logging: 
Enables/Disables the S.M.A.R.T. error logging support on the drive. 
 

Command set description: 
The collection and storage of drive health related statistics. 

 
S.M.A.R.T. Self Test: 
Enables/Disables a drives ability to perform a  S.M.A.R.T. self test. 
 

Command set description: 
Causes the drive to perform a test of its health. 

 
S.M.A.R.T. Conveyance Self-Test: 
Enables/Disable a drives ability to perform a S.M.A.R.T. conveyance self test. 
 

Command set description: 
S.M.A.R.T. test designed to check if any damage occurred between the time the 
drive was manufactured and the time it was put into use. 

 
S.M.A.R.T. Selective Self-Test: 
Enables/Disables a drives ability to perform a S.M.A.R.T. selective self test. 
 

Command set description: 
Similar to a normal Self-Test, but the user can specify specific areas of the drive to 
test. 

 

PSIClone™ Tips:  
To save DCO Values, click the ‘Save’ button.  Once saved, DCO values may be reloaded using 
the ‘Load’ button.   

This feature is valuable if a user needs to restore a drive to its original state after having made 
changes to the DCO. 
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Device Options 
The Device Options tab provides a method for setting values which affect PSIClone™ 
functionality.  This screen may be used to configure device options and error handling. 

 
Figure 45 - Device Options tab 

Device Options 
Device options are set using the left portion of the screen, as shown in Figure 46. 

 
Figure 46 - Device Options 
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Power Down On Complete 
Default: Not selected 

Selecting ‘Power Down On Complete’ instructs the device to power off attached drives 
after it completes a task. 

Run Commands in Reverse 
Default: Not Selected 

Selecting ‘Run Commands in Reverse’ will instruct PSIClone™ to perform actions in LBA 
descending order.  The default is to run in ascending LBA order.   

Enable Buzzer 
Default: Not Selected 

Enabling this option will cause PSIClone™ to sound an audible alert upon completion of 
an action.  

Compress Images 
Default: Not Selected 

Enabling this option instruct PSIClone™ to employ a compression algorithm when 
creating image filesets.   

Transfer Rate  
Default: Auto 

Transfer rate set to the default, ‘Auto’, allows PSIClone™ to use the most efficient 
transfer rate for the attached drives. 
  

Power On Timeout (ms) 
Default: 20,000 

The value set here defines how long PSIClone™ will wait for a response from an 
attached drive after supplying power to the side of PSIClone™ to which the drive is 
attached. 

Pass 1 Timeout (ms) 
Default: 4,000ms (4 seconds) 

The value set here will define how long PSIClone™ and CPR Toolbox™ are configured to 
wait for a device to recover from an error and return to ‘ready’ state. Values from five 
hundred milliseconds (½ second) to sixty thousand milliseconds (60 seconds) are 
allowed. 

Image File Size 
Default: 2GB 

The value set here is used in conjunction with the imaging function included with 
PSIClone™. The available values are 700 MB, 1 GB and 2GB; the size chosen will define 
the size of drive image file segments output by PSIClone™. Note: PSIClone™, Hammer™ 
and CPR Toolbox™ support 700MB to enable transfer of image segment files to CD 
media. 

  



Error Handling Options 
CPR Toolbox™ provides certain user-configurable control over how errors are handled.  These 
options are displayed on the right side of the ‘Device Options’ tab, as shown in Figure 47. 

 
Figure 47 - Error Handling Options 

Selecting ‘Perform Error Recovery’ enables Error Handling options.  Each of the sections within 
Error Handling Options are worthy of discussion.   

Sections titled ‘Soft Reset’, ‘Hard Reset’ and ‘Power Cycle’ are used to select what action, if any, 
CPR Toolbox™ and the PSIClone™ device will take upon encountering errors.  Checkboxes 
marked ‘On Error’ and ‘On Loss of Readiness’ are available in each of these sections and may 
be selected to indicate the users’ choice of actions if an error is encountered. 

The field labeled ‘Jump Size on Error (sectors)’ is used to define how many sectors should be 
skipped over if an error is encountered.   This is most useful when used in conjunction with the 
‘Perform Two Passes’ checkbox.     

If ‘Perform Two Passes’ is checked and an error is encountered on first pass, PSIClone™ flags 
the sector for later review and proceeds after jumping ahead by this value.  Valid values range 
from 1 to 4,294,967,295. 

The Pass 2 Timeout (ms)’ field is used to define how long CPR Toolbox™ and PSIClone™ are 
configured to wait for a device to recover from an error and return to ‘ready’ state on its second 
pass.  Values from five hundred milliseconds (½ second) to sixty thousand milliseconds (60 
seconds) are allowed. 

Clicking ‘Restore Defaults’ will reset all CPR Toolbox™ values on this screen to their default 
values.  Clicking ‘Refresh’ will synchronize the CPR Toolbox™ using values currently present in 
PSIClone™.  Clicking ‘Save’ will save the new user defaults to NVRAM. 
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Drive Info 
 

Clicking Drive Info reveals two (2) submenu choices, Identify Device and View S.M.A.R.T.   

 
Identify Drive 
Clicking this toolbar button will cause the CPR Toolbox™ to issue an ATA ‘Identify 
Device’ command to the selected drive.  Information retrieved is presented as a tabbed 
screen in the main section of the CPR Toolbox™.  The ‘Identify Device’ data tab is 
depicted in Figure 48.  The ‘Save’ button may be used to write this information to a file.  
The section of output titled  

-----Integrity Word----- 
which is presented at the bottom of the output contains a checksum which is used to 
verify the accuracy of the data being displayed.  If the checksum validates, the value 
Valid will be displayed. 

 
Figure 48 - Identify Drive 
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View S.M.A.R.T. 
Self-Monitoring, Analysis, and Reporting Technology, or S.M.A.R.T., is a monitoring 
system for computer hard disks to detect and report on various indicators of reliability, 
in the hope of anticipating failures. 

The technical documentation for S.M.A.R.T. is in the AT Attachment standard.7 

Clicking the View S.M.A.R.T. button will retrieve and display current S.M.A.R.T. data for 
the selected drive.  Figure 49 depicts the View S.M.A.R.T. results displayed in a tab of 
the main window.  Output may be saved by clicking ‘File/Save’ or by pressing CNTRL-S 
on the keyboard.  

 
Figure 49 - View S.M.A.R.T 

The first two lines of output in the View S.M.A.R.T. display contain Attribute and 
Threshold Checksum values. If the data presented is valid, PASS will be displayed for 
these values. 

The View S.M.A.R.T. display includes columns of information.  These are: 

• Attribute: S.M.A.R.T. Attribute as described in the ATA specification 
• Name: Canonical meaning of the S.M.A.R.T. attribute 
• Value: The current value of the given S.M.A.R.T. attribute 
• Worst: Lowest value recorded to date for the selected device for the given 

S.M.A.R.T. attribute 
• Thresh: Reference value.  ‘Value’ should be higher than this reference value for 

the attribute to be in a ‘working state’ 
• Raw (Hex): Vendor specific value for a given S.M.A.R.T. attribute in hexadecimal 

format 
• Raw (Decimal): Vendor specific value for a given S.M.A.R.T. attribute in decimal 

format 
• Status: Lists the current status for the attribute.  Potential status listings are 

PASS or FAIL, followed by additional information.  The additional information 
listed is dependent upon the type of attribute being monitored by S.M.A.R.T. 
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http://www.t13.org/Documents/UploadedDocuments/docs2006/D1699r3f-ATA8-ACS.pdf


 
Drive Utilities 
 

Clicking Drive Info reveals four (4) submenu choices, Sector Viewer, eDrive™, gClone™ and 
gRase™.   

NOTE: 
The gRase™ utility is functional 
when working with CPR Toolbox™ 
in conjunction with CPR Tools data 
eradication device, Hammer™ 

 

Sector Viewer 
Beginning with this version of CPR Toolbox™ additional capabilities have been built into the 
Sector Viewer.  To best describe the functionality of the CPR Toolbox™ Sector Viewer, Figure 50 
displays the Sector Viewer, with five (5) distinct sections encircled, labeled A through E. 

Figure 50 - Sector Viewer 
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Drive Selection 

 
This section of the Sector Viewer provides the ability to select from or switch between drives for 
which sectors are displayed.  

As is the case with the drives depicted above, the Drive Selection window also indicates if an 
HPA has been detected by marking the drive with *HPA.  Similarly, if DCO Settings which affect 
drive size are in place, the drive will be marked with *DCO. 
 
Navigation 

 
This section of the Sector Viewer provides the ability to move through sectors in a variety of 
ways. 

Seek To 
By entering an LBA value and clicking the ‘Seek To’ button, users may jump to a specific 
LBA. 

First 
Clicking the button marked ‘First’ will cause the sector viewer to display the first LBA. 

Prev / Next 
Clicking the buttons marked ‘Prev’ or ‘Next’ will cause the sector viewer to display one 
sector previous or one sector after the currently viewed sector. 

Last 
Clicking the button marked ‘Last’ will cause the sector viewer to jump to the last LBA. 

 

The last line in this section displays the current LBA. 

Drive Information 

 
The Drive Information section presents the current drive’s Serial Number.  If an HPA or DCO is 
detected, this is indicated, as shown above. 
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Sector Viewer 
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The main section of the Sector Viewer displays the data found in the current sector.  The data is 
provided in both hexadecimal and ASCII formats.  Users may use the horizontal scroll bar to 
scroll forward and back through the available LBAs. 

Enhanced Sector Viewer Functionality 
CPR Tools has developed an add-on module for the Sector Viewer.  Available as an add-on 
module8, the Enhanced Sector Viewer includes the ability to edit data from within the sector 
viewer.   

At the lower right of the Sector Viewer main window depicted above, users will notice the ‘Read 
Only’ button which is depressed.  This indicates that read-only mode is enabled (the default 
setting for Sector Viewer.)  Users of the Sector Viewer module who have not purchased the 
additional editing functionality (Advanced Sector Viewer), will see this button ‘greyed out’ and 
unavailable. 

For those users who have purchased the Advanced Sector Viewer capability, the ‘Read Only’ 
button will be clickable, enabling the user to toggle between ‘Read Only’ and ‘Read/Write’ as 
shown in Figure 51 and Figure 52.  

 
Figure 51 - Read Only Mode 

 
 

Figure 52 - Read/Write Mode 

 
                                          
8 Available as an add-on module; additional charges apply. 



   

Subsequent to committing any changes made while in 
‘Read/Write’ mode, CPR Toolbox will prompt to confirm. 

 

 

 

 

eDrive™ 
The eDrive™ module provides the ability to create errors on a drive attached to Side B of 
PSIClone™.  This facility is useful for testing hardware, software or in training. 

To launch eDrive™, highlight a drive attached to Side B of PSIClone™, then click ‘Drive 
Utilities’/’eDrive’. 

Not all drives support this function.  When 
using a drive which does not support eDrive™, 
CPR Toolbox™ will present a message to this 
effect. 

An updated list of known supported drives is 
available from the CPR Tools Website at 
http://www.cprtools.net/downloads. 

When working with a drive which supports eDrive™ functionality, the main eDrive screen will be 
displayed, as depicted in Figure 53. 
 

 
Figure 53 - eDrive™ main screen 

To generate an error on a single LBA, select the radio 
button labeled ‘Single Error (Enter LBA).  This is the 
default selection.  Enter the LBA for which an error 
should be generated and click the ‘Create Errors’ button.  
eDrive™ will generate the error as requested.  Output is 
shown in the ‘Results’ window at the right of the screen.   

eDrive™ Tips: 

Errors created using eDrive™  are 
‘Read’ errors.   Writing to these 
marked sectors will remove the 
read errors created by eDrive™.   
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Figure 54 depicts a single error written to sector 63 of the subject drive. 
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Figure 54 - eDrive™ has successfully marked sector 63 as unreadable 

To mark multiple sectors as unreadable, the user may simply create multiple single sectors; 
alternately, an ‘Error File’ may be created.  Error File(s) should be created as simple ASCII text 
files; the Windows utility ‘notepad.exe’ is suitable for the creation of Error Files which may be 
used with eDrive™.   
 
Error Files for use with eDrive™ should contain one LBA per line.  To load an Error File, select 
the radio button labeled ‘Load Error File’, then click the ‘Browse’ button.  Navigate to the 
location where the error file was saved and click ‘Open’.  Upon successful loading of the Error 
File, eDrive™ will display the contents of the error file in the Results window, as shown in Figure 
55. 
 

 
Figure 55 - eDrive™ has successfully loaded an Error File 

Click ‘Create Errors’ to instruct eDrive™ to mark all sectors listed in the Error File as 
unreadable. 

 



Figure 56 depicts the output of the Results window after eDrive has marked the listed LBAs as 
unreadable. 

 
Figure 56 - eDrive has successfully marked all listed LBAs as unreadable 

The output displayed in the Results window may be saved, printed or cleared using the buttons 
provided. 
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gClone™ 

CPR Toolbox™ Tips:  

gClone™ does not support all hard 
drives.  

If an unsupported drive is 
encountered, gClone™ will present a 
message box to that effect. 

A list of currently supported drives is 
available from the CPR Tools website 
at http://www.cprtools.net/downloads 

A breakthrough in forensics, gClone allows the 
reading of physical sectors which have been listed 
in the drive’s defect list, bypassing any remapping 
performed by the drive’s defect mapping 
mechanism.  Data found in sectors listed in the 
defect list will represent the last write to those 
sectors.   
 
As the sectors being addressed have been marked 
as defective, not all attempts to read will be 
successful.  Retry count levels are adjustable in the 
gClone™ screen. 
 
Launching a ‘read’ from this screen will instruct CPR Toolbox™ to first backup the data stored in 
the defect list’s remapped sectors to ensure data integrity.   
 
Only drives connected to Side A of PSIClone™ may be addressed by gClone™. 
 
Data retrieved from these sectors may then be saved to the host system running CPR 
Toolbox™.   
  
Figure 57 depicts the initial gClone™ screen. 
 

 
Figure 57 - Initial gClone™ screen 
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Before initiating gClone™, set a value for ‘Retry Count’.  The value entered here will provide 
CPR Toolbox™ and PSIClone™ with a limit to the retries attempted when a read error occurs.  
The default value is 0 (no retries).   

Initiate gClone™ by clicking the ‘Read’ button.  CPR Toolbox™ will present a ‘Save As’ dialog 
box for the user to select a storage location for the sector data.  The data saved will be a binary 
(.bin) file.  The default location for storage of the .bin file is C:\Documents and 
Settings\<user>\My Documents\CPR Tools Utilities Suite. 

Click the ‘Read’ Button to initiate the gClone™ process.  If no 
errors are found, CPR Toolbox™ displays a message. 

 

If entries in the defect list are found, they are listed at the 
right of the screen. 

During the gClone™ process, information is provided in the 
‘Results’ window at the right of the screen. 

If the checkbox labeled ‘Prepend LBA number to saved data’ is checked, the output will include 
the prepended LBA.  This is shown encircled in red in Figure 60, located on page 84 of this 
guide. 

 

 
Figure 58 - gClone™ in process 

When finished, gClone™ displays a completion message.   
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Figure 59 - gClone™ has completed 

Figure 60 and Figure 61 depict samples of the stored .bin file as viewed in a hex-editor.  Figure 
60 shows actual data. 

As the checkbox marked ‘Prepend LBA number to saved data’ was checked, the LBA from which 
the data has been saved is prepended to the data itself. Figure 60 shows this encircled in red.  
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Figure 60 - Data from defect-listed sector 

 
  

 

     Page 84 of 141 

PSIClone™ User’s Guide 

 



FFigure 61 reepresents a sector from which dataa was unablee to be readd.   

 

  

Figure 61 -
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Recover 

Clicking the ‘Recover’ button reveals six (6) submenu items.   

These are: 

• Image Restore 
• Advanced Recovery9 
• iFirmware™9  
• Mount/Unmount Drive 

 

 
 

Image Restore 
Selecting ‘Image Restore’ launches the CPR Toolbox™ image restore module.  The opening 
screen is presented in Figure 62. 

 
Figure 62 - Image Restore initial screen 

If an image fileset has been created using PSIClone™ and/or CPR Toolbox™, the Image Restore 
module can be used to restore the fileset to an attached destination drive.  If the image fileset 
represents a working file system, the result will be a mountable file system on the destination 
drive.  Using Image Restore requires the image fileset be available to the host operating 
system.   

This may be accomplished in a number of ways.  The first method is to attach the source drive 
(the drive containing the image fileset) directly to the host system’s bus.   

 
9 Available as an add-on module; additional charges apply. 



The Image Restore module works with both compressed and uncompressed image filesets 
created by PSIClone™ and/or CPR Toolbox™.  Compression settings are managed on the Device 
Options tab of CPR Toolbox™ or within the Options submenu directly on the PSIClone™ device. 
 
Another method for working with image filesets is through the use of a new CPR Toolbox™ 
feature called ‘Mount/Unmount Drive’.  Using Mount/Unmount Drive, CPR Toolbox™ uses the 
PSIClone™ host USB connection to enable the host to see the source drive as a ‘Removable 
Storage Device’.   

Mount/Unmount Drive is discussed later in this User’s Guide, in the section titled Mount / 
Unmount Drive, on page 120. 

Regardless of the method used to attach the source drive to the host, a destination (target) 
drive also needs to be attached to the host.  This destination drive will be the recipient of the 
reconstructed drive image. 

Begin by selecting a directory which contains an image fileset.  Once selected, segment files will 
appear in the box labeled ‘Input Files’. 
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Figure 63 depicts the Image Restore screen after having 
selected an image fileset.  The fileset in the example shown 
is made up of five (5) segments.  Note that the destination 
drive for the restored image has been selected from the 
drop-down list of available drives. 

 

 

CPR Toolbox™ Tips: 
Any data present on the selected 
destination drive will be 
overwritten when the image is 
restored. 

Figure 63 - Preparing to restore an image fileset 

Clicking the ‘Restore’ button initiates the restore process.  The restoration process may be 
monitored on the right side of the screen.  As each file in the ‘Input Files’ list is processed, its 
filename will appear in the ‘Current File Name’ field.   

The number of files queued for processing will be shown in the ‘File(s) Remaining’ field.   

The ‘Current File Progress’ status bar shows the progress of the individual file being processed.   

The ‘Overall Progress’ status bar shows the progress of the total restoration process.   

Figure 64 depicts a restoration in progress. 



 
Figure 64 - Image restoration in progress 

 
When the restoration is complete, Image Restore alerts the user. 
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Figure 65 - Image Restoration has completed 

 
Click ‘OK’ to clear the ‘Image restoration completed’ message.  Click ‘Quit’ to close the Image 
Restore module and return to CPR Toolbox™. 
 
  



Advanced Recovery10 
Beginning with this release, CPR Toolbox™ includes the ability to perform advanced data 
recovery techniques.  The goal of the Advanced Recovery module is to provide methods for 
cloning drives which have errors.  Advanced Recovery (AR) features can be enabled by 
purchasing the add-on module from CPR Tools (http://www.cprtools.net/store).   
 
Once enabled, AR provides the ability to: 

• Customize recovery algorithms 
• Apply Software Head Maps 

o Created in the module command drop-down menu of the iFirmware™10 module 
• Perform Hot Swaps of drive PCBs 
• Save specific custom algorithms for re-use or modification 
• Keep detailed notes for each recovery effort 
• Keep forensic logs of all actions (Journal functions) 

 
Selecting the Advanced Recovery menu item displays the initial AR screen. 
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Figure 66 - Advanced Recovery, initial screen 

 

  

                                          
10 Available as an add-on module; additional charges apply. 

http://www.cprtools.net/store


The topmost section of the AR screen shows connected drives. 

 
Figure 67 - Drives connected to PSIClone™ - Advanced Recovery 

As with the Control Panel module, drive power is controlled by 
the two button indicators to the left of each drive shown.  Figure 
67 depicts both drives powered; the buttons show ‘green’. 

Commands 
Beneath the ‘Source Drive’ shown at left, a Commands drop-
down button is visible.  Clicking ‘Commands’ reveals eight (8) 
menu choices.  These are: 

1. Hard Reset 
2. Soft Reset 
3. Identify  
4. Hot Swap 
5. SMART on 
6. SMART off 
7. Enable Read Cache 
8. Disable Read Cache 

All ‘Commands’ actions affect the drive connected to Side A (Source Drive) of PSIClone™. 

Hard Reset 
Selecting Hard Reset will cause the drive to be hard reset.  Once the reset 
has completed, CPR Toolbox™ presents a message box. 

Soft Reset 
Selecting Soft Reset will cause the drive to be issued a soft reset command.  
Once the reset has completed, CPR Toolbox™ presents a message box. 

Identify 
Selecting Identify will issue an ATA Identify 
Device command to the drive.  Output from 
the command is displayed in a message 
window. 

Clicking ‘Save’ will allow for saving the data 
as a plain text file.  The default location is 
C:\Documents and Settings\<user>\My 
Documents\CPR Tools Utilities Suite. 
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Hot Swap 
Hot Swapping a known-good PCB from a donor drive onto a recovery subject drive should be 
considered when the recovery subject appears physically sound but exhibits issues which are 
likely attributed to firmware corruption. 

When recovery efforts include the need to hot swap a PCB from a suitable donor drive to a 
recovery subject, connect the donor drive to Side A of PSIClone™, power the drive and select 
Hot Swap. 

CPR Toolbox™ will present a message box to verify 
that the donor drive is powered. 

If the drive is not powered, click No.  CPR Toolbox™ 
will prompt with an additional message box and 
provide an opportunity to connect and power the 
donor drive. 

If the donor drive is connected to Side A of PSIClone™ and is powered, click ‘Yes’; doing this 
will cause the donor drive to be placed into ‘Standby’.  CPR Toolbox™ will present a message 
box with instructions, as depicted in Figure 68. 

 
Figure 68 - Hot Swapping a PCB 

 

Click ‘Ready’ to complete the hot swap process.  CPR 
Toolbox™ and PSIClone™ will attempt to bring the drive out of 
‘Standby’ mode and into a ready state.  When complete, a 
message is displayed. 
 
 
 
 
 

Best Practices for using Hot Swap functionality: 

CPR Tools recommends first obtaining a suitable donor drive.  Prior to performing 
a Hot Swap, copy all firmware modules from the donor drive to the host system 
running CPR Toolbox™.  This may be done through the use of the iFirmware™ 
module, which is a fee-based add-on. 

Once the donor drive’s firmware has been saved, connect the donor drive to Side 
A and prepare to hot swap the ‘good’ PCB onto the recovery subject. 
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Smart On 
Select ‘Smart On’ to turn on the S.M.A.R.T. feature set for 
the drive attached to Side A of PSIClone™.  CPR Toolbox™ 
displays a confirmation message. 
 
 
 
 
 
If the S.M.A.R.T. feature set is already enabled, CPR 
Toolbox™ presents a message to that effect.  
 
 
 
 
 
 
 
Smart Off 
Select ‘Smart Off’ to turn off the S.M.A.R.T. feature set for 
the drive attached to Side A of PSIClone™.  CPR Toolbox™ 
displays a confirmation message.   
 
 
 
 
 
 
If the S.M.A.R.T. feature set is already disabled, CPR 
Toolbox™ presents a message to that effect.  
 
 
 
 
 
 
 
Enable Read Cache 
Select ‘Enable Read 
Cache’ to enable the 
read cache for the drive 
attached to Side A of 
PSIClone™.   CPR 
Toolbox™ displays a 
confirmation message. 

 
Disable Read Cache 
Select ‘Disable Read 
Cache’ to disable the 
read cache for the drive 
attached to Side A of 
PSIClone™.   CPR 
Toolbox™ displays a 
confirmation message. 
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Advanced Recovery - The Clone Tab 
As stated earlier, the Advanced Recovery cloning capability was designed for working with 
drives which contain errors that require special handling.  Key features of the Advanced 
Recovery module include the ability to create custom algorithms when working with difficult 
recovery subjects.  Prior to describing the methods for using Advanced Recovery, a definition of 
certain terms used in reading from drives is in order. 
Advanced Recovery Terms 

• Jumper Advanced Recovery Tips: 
Each of the three (3) types of 
passes / algorithms defined 

• Jumper 
• Refiner 
• Attacker 

can be further configured for 
number of retries and direction, as 
well as many more options, all of 
which will be discussed further. 

o Jumper reads sectors until an error is 
encountered.  When an error is 
encountered, a pre-defined number of 
sectors is skipped/jumped over; reading of 
sectors is then resumed. 

• Refiner 
o Refiner reads sectors until an error is 

encountered.  When an error is 
encountered, Refiner will approach the 
error sector from the opposite side of the 
current read direction in an attempt to read as much data as possible before re-
encountering the error sector. 

• Attacker 
o Attacker uses PIO mode exclusively and attempts to read sectors marked as error 

sectors.   
• Algorithm 

o An Advanced Recovery Algorithm is an instruction set.  The default algorithm 
provided consists of one Jumper, one Refiner and one Attacker pass.  Users may 
create and save custom algorithms 
using any combination of passes 
and/or specific error recovery 
options.11 

• Journal 
o An Advanced Recovery Journal is a 

record of all recovery actions taken 
for a given drive and provides a 
detailed, forensically sound audit 
trail. 

Creating a Journal  
Attempting to recover data using the Advanced 
Recovery module requires that a journal be created.  
This may be accomplished at the right side of the 
main screen or from the Journal tab.   

Users may enter a Journal name, brief description 
and complete the ‘Recovery Options’ and ‘Error 
Handling Options’ sections.   Once the journal has 
been successfully configured, click ‘Create’. 
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11 This guide uses the term ‘algorithm’ to refer to a collection of one or more ‘passes’ configured for a data recovery 
effort 

Figure 69 - Creating a Journal 



Recovery Settings 
Recovery Journal 
The Recovery Journal section displays the selected Journal Name, Journal Location and Source 
Drive. 

Recovery Options 
Users may choose to specify Recovery Options and Error Handling Options.  These are depicted 
in Figure 70.  By default, the Start and End LBA 
fields will be populated by the first and last 
logical sector of the drive connected to Side A of 
PSIClone™.  If so desired, users may set specific 
start and end LBAs for the recovery effort. 
• Start LBA 

o Enter LBA at which the clone should 
begin 

• End LBA 
o Enter the LBA at which the clone 

should stop 
• MaxLBA 

o Non-editable.  This value represents 
the current max of the drive. 

• SafeClone Threshold 
o Specifies the number of errors which 

must be reached before the drive is 
shut down. A value of zero (0) means 
‘never shut down’ 

• Prompt after each pass 
o Set to Yes to be prompted after each 

pass 
• Ignore Skipped Sectors12 

o Set to Yes to Ignore Skipped Sectors 
• Ignore ECC Error Sectors12 

o Set to Yes to ignore sectors which 
have ECC errors 

• Ignore IDNF Error Sectors12 

o Set to Yes to ignore sectors which 
have IDNF errors 

Figure 70 - Recovery Options 

• Ignore Timeout Sectors12 
o Set to Yes to ignore sectors which timeout 

• HEaD Map13 
o Head Enabling and Disabling (HEaD Map) is a software head mapping facility 

available to users who have purchased the iFirmware module. Through use of HEaD 
Map, users may instruct PSIClone™ to disregard signals received on specific heads. 

As each field is highlighted, descriptive help text is displayed.  In Figure 70, this area is shown 
encircled in red. 

Users may modify each field as needed or accept the displayed settings. 
                                          
12 Applicable to ‘attacker’ pass only 
13 Available as an add-on module; additional charges apply. 
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Error Handling Options 
Algorithm 
Select a pre-defined algorithm from the drop down list.  Users may create custom algorithms 
using the ‘Error Options’ tab discussed later in this guide. 

Intensity 
Settings may be: 

• Algorithm Defined 
o Select this to allow the selected algorithm determine number and type of passes 

• Off 
o Select ‘Off’ to instruct CPR Toolbox to proceed with the following paradigm: 

 ECC err:  0 retries, Do Nothing 
 IDNF err: 0 retries, Do Nothing 
 Timeout:  0 retries, Do Nothing 

• Light  
o Select ‘Light’ to instruct CPR Toolbox to proceed with the following paradigm: 

 ECC err:  1 retry, soft reset 
 IDNF err: 1 retry, soft reset 
 Timeout:  1 retry, soft reset 

• Moderate 
o Select ‘Moderate’ to instruct CPR Toolbox to proceed with the following paradigm: 

 ECC err:  3 retries, hard reset 
 IDNF err: 3 retries, hard reset 
 Timeout:  3 retries, hard reset 

• Aggressive 
o Select ‘Aggressive’ to instruct CPR Toolbox to proceed with the following 

paradigm: 
 ECC err:  6 retries, hard reset 
 IDNF err: 6 retries, hard reset 
 Timeout:  6 retries, hard reset 

 
The ‘Recovery Notes’ section may be used to enter notes specific to the recovery effort.  The 
contents of the ‘Recovery Notes’ window will be saved to the journal’s log each time the ‘Save 
Note’ button is clicked. 
 
 
  



Figure 71 depicts the Clone tab after selecting a Journal, setting Recovery and Error Handling 
Options.  Note that the progress area, encircled in red, displays a ‘Not Read’ of value of 
20,000,001 sectors.  This represents the total sectors (0 through 20,000,000).  The progress 
area also displays values for number of sectors read successfully, number of sectors skipped 
(this pass) and the number of sectors read with errors. 

 
Figure 71 - Ready to being cloning with Advanced Recovery 

 

 

To begin the cloning process, click the ‘Start’ Button.   

 

 

When a clone is initiated, 
the progress area will 
begin to provide 
indications which describe 
the progress of the clone.  
The information area, 
shown in Figure 72, 
provides important information regarding current action being performed. 

Figure 72 - Information Area during a clone process 

The ‘Block Description’ is useful in that it provides a view of the block currently being acted 
upon.   
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The progress area provides additional 
information about the current action.  
The topmost line indicates the 
number of sectors not yet read.  As 
the clone progresses, this number 
decreases and the blue progress bar 
moves from right to left. 

The second line indicates the number 
of sectors which have been read 
successfully.  As sectors are read, 
the green progress bar moves from 
left to right. 

The third line indicates the number of 
sectors skipped while the fourth 
shows how many sectors were read 
with errors.  Progress indicators on 
Skipped and Read with Error are 
yellow and red, respectively. 

At the bottom of Figure 74, arrows 
indicate the direction of the clone.  In 
the example shown, the current pass 
moves backwards through the 
available LBAs.  This is indicated by 
the blue arrow at left.  A pass 
moving forward would be indicated 
by the right arrow being illuminated.  
The Pause button may be used to 
interrupt a clone process.   Figure 73 - Advanced recovery clone in process 

 

 Figure 74 - Clone proceeds in reverse 

 

If a clone has been paused previously, the ‘Start’ 
button becomes available.  Clicking ‘Start’ will cause 
CPR Toolbox to ask if the previously paused clone 
should be resumed or if a new clone should be 
initiated. 
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The Journal Tab 
The Journal Tab provides an easy to use, thorough view of the recovery effort with which it is 
associated. 

 
Figure 75 - The Journal Tab 

Figure 75 depicts the Journal Tab prior to selecting a recovery effort’s journal.  The ‘Create 
Journal’ button may be used to create a new journal.  Creating a Journal is described in the 
section titled Creating A Journal, on page 93.   
  

 

     Page 98 of 141 

PSIClone™ User’s Guide 

 



Figure 76 depicts the Journal tab after having selected a Journal which is associated with a 
recovery effort 
 

 
Figure 76 - The Journal Tab - Recovery Data Shown 

A journal may be viewed during the recovery effort.  For this reason, a ‘Refresh’ button is 
available so that current actions can be refreshed to the screen. 
Figure 76 depicts a view of the log file; clicking the radio button labeled View Vector File will 
change the view to show vector details.  Figure 77 depicts the Journal Tab while showing a 
vector file for the current recovery. 
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Figure 77 - Vector file for the selected Journal 



The Error Options Tab 
A key feature of the CPR Toolbox™ Advanced Recovery module is the ability to customize error 
handling options.  This facility is provided by the Error Options tab.  Users may design specific 
methods for each pass using the fields at left.   

 
Figure 78 - Advanced Recovery - The Error Options Tab 

Select a Base Type.  Valid selections are Jumper, Refiner and Attacker.  These terms are 
defined in this guide in the section titled Advanced Recovery - The Clone Tab, on page 93.  
Selecting one of the Base Types will fill in the remaining fields with default values.  Figure 78 
shows the default values for ‘Jumper’.  Default values for ‘Refiner’ and ‘Attacker’ are shown 
below. 

 
Figure 79 - Refiner and Attacker default values 
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Customize values for any one of the Base types, then click ‘Add Pass’ to add that configuration 
to the list at right.  Users may choose to add one or more passes, specifying values for each.  
These instruction sets are referred to as algorithms and may be saved for future use; in this 
way users are granted the ability to create base algorithms for handling specific models or 
families of drives. 

To save a constructed 
algorithm, provide a 
name and click the 
‘Save Algorithm’ button 
at top.  Figure 80 
shows a custom 
algorithm ready to be 
saved.  The ‘Save 
Algorithm’ button and 
name entry field are 
encircled in red. 

 

  

Figure 80 - Saving a custom algorithm 
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iFirmware™14 
Beginning with this release, CPR Toolbox™ includes the ability to perform firmware 
manipulation on supported drives.  The goal of the iFirmware™ module is to provide methods 
for copying, saving, repairing and replacing firmware modules.  iFirmware™ features can be 
enabled by purchasing the add-on module from CPR Tools (http://www.cprtools.net/store).   
As working with hard drive firmware often includes working with drives which have firmware 
problems, CPR Tools recommends that all drives are powered off prior to launching the 
iFirmware™ application.   This will ensure that no commands, other than those specified by the 
user, are being sent to the drive. 
The iFirmware™ application allows the user to perform the following advanced actions on 
firmware modules: 

• Read 
• Edit 
• Write 
• Backup 
• Restore 
• Repair 

 
Additionally, iFirmware™ allows for: 

• Enabling and disabling of heads 
• Service Area Verification 
• Alternate Resource Drive Start (ARDS) 
• Automatic Identification & Repair (AIR) 

 
Reading firmware modules from an attached drive 
Features of this portion of the application include the following functionality: 

• Read and store hard drive profiles to the host system 
o Hard drive profiles refer to a folder structure established to contain collected 

information pertaining to a given hard drive. 
 Profiles are saved to the host system in C:\Documents and 

Settings\<user>\My Documents\CPR Tools Utilities Suite 
RC\iFirmware\ in folders which use the Drive Manufacturer, Model and 
Serial Number as the folder name. Example: C:\Documents and 
Settings\<user>\My Documents\CPR Tools Utilities Suite 
RC\iFirmware\Maxtor 4D040H2_D204W44E 

• Read and store individual firmware modules to the host system 
o Individual firmware modules are saved to  

C:\Documents and Settings\<user>\My Documents\CPR Tools Utilities 
Suite RC\iFirmware\<profile>\Modules 

 
  

                                          
14 Available as an add-on module; additional charges apply. 

http://www.cprtools.net/store


To read firmware modules from a hard drive, connect a drive to either side of PSIClone™ and 
launch CPR Toolbox™. 

Select iFirmware™ from the ‘Recover’ button on the toolbar.  CPR Toolbox™ will present the 
screen depicted in Figure 81. 

 
Figure 81 - iFirmware™ initial screen 

For the purposes of this example, let us assume that a Maxtor 
drive is connected to Side B of the PSIClone™.  At the left, locate 
the ‘Donor Drive (B)’ section and click ‘Powered’ to supply power 
to the Side B of the PSIClone™. 

 

CPR Toolbox will prompt the user to indicate the data port to 
which the drive is attached. 

This is done to prevent any unnecessary commands 
being sent to the attached drive(s). 

Select the appropriate port to continue.   

 

To initialize the 
drive, click the ‘Initialize’ button.  CPR Toolbox will prompt 
for a profile selection.  Select from an existing profile or 
create a new one by clicking the radio button labeled 
‘Create New’.  If ‘Create New’ is chosen, the fields marked 
Model Number, Serial Number and Number of LBAs may be 
automatically filled if by clicking the ‘Identify Drive’ button. 

NOTE: This will send an ATA Command (Identify Device) 
 

With the drive powered and initialized, we may now 
proceed to examining the firmware modules. 
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Firmware Modules 
To work with firmware modules, select a Module Input Source 
(encircled in RED) from the dropdown box, depicted at right. 

Once an input source has been selected, the dropdown labeled 
‘Module Commands’ will be populated, as depicted in Figure 82. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 82 - Module Commands 
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Save Module Map 
Selecting ‘Save Module Map’ will produce a text file which outlines the module map for the 
selected source (drive or stored profile).  A message box will be displayed indicating the name 
and location of the file being saved. 

 
The text file uses an ‘importance ratings system’ or “IRS” which values the importance of each 
module from one (1) to four (4) and an asterisk (*).  A value of one (1) is highly important and 
four (4) indicates far less importance.  An asterisk (*) indicates the importance is not yet 
known.15 

Listed from left to right are the Module ID, the Service Area LBA at which the module begins, 
and the Module Size in bytes. 

Module ID: MX_ST_CFG_3 (0000) | Start SLBA: 00008022(0x00001F56) | Importance: 04 | Module Size(in bytes): 00001536 | 
Module ID: SCRIPT      (0001) | Start SLBA: 00008025(0x00001F59) | Importance: 04 | Module Size(in bytes): 00004096 | 
Module ID: MOD_0002    (0002) | Start SLBA: 00008033(0x00001F61) | Importance: *  | Module Size(in bytes): 00000512 | 
Module ID: MOD_0003    (0003) | Start SLBA: 00008034(0x00001F62) | Importance: *  | Module Size(in bytes): 00001024 | 
Module ID: MX_ST_CFG_1 (0004) | Start SLBA: 00008037(0x00001F65) | Importance: 04 | Module Size(in bytes): 00000512 | 
Module ID: MOD_0005    (0005) | Start SLBA: 00008316(0x0000207C) | Importance: *  | Module Size(in bytes): 01167360 | 
Module ID: MOD_0006    (0006) | Start SLBA: 00008039(0x00001F67) | Importance: *  | Module Size(in bytes): 00004096 | 

 

Working with drives in Safe Mode 
Color Drive Family Name 
Green ARES C64K 
Pink FALCON 

Magenta SABRE 
Yellow CALYPSO 
Red N40P 

The next section of this guide describes working with ARDS 
(Alternate Resource Drive Start) capabilities.  Using ARDS 
requires the setting of drives into ‘safe mode’. 
Begin by determining the drive family to which the subject 
drive belongs. 
For Maxtor PATA drives, the drive family corresponds to the 
color coded serial number label which is typically on the edge 
of the drive. 
 
Once the drive family has been determined, follow this guide to 
place the drive jumpers in the appropriate position for the drive 
to be in safe mode. 
 
 

 

 

 

 

                                          
15 CPR Tools is continuing research into the importance of modules that are currently undetermined; as new 
information is confirmed, updates to this application are provided through new CPR Toolbox™ releases. 
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Create ARDS 
Alternate Resource Drive Start (ARDS) is a useful utility when encountering drives with 
firmware corruption which prohibit the drive from starting. 
Begin by obtaining a suitably compatible drive, setting the Safe Mode jumpers on the drive and 
attaching it to either Side A or Side B of PSIClone. 
To create an ARDS file, select ‘Create ARDS’.  CPR Toolbox will create the file and will present a 
message box detailing the file’s location. 

 
Figure 83 - ARDS saved 

 

 

To use an ARDS file, click the arrow beside the 
‘Powered’ button to display the message ‘Start 
drive using ARDS’.  
Clicking the ‘Start drive using ARDS’ message will 
cause CPR Toolbox to prompt the user for information regarding the safe mode jumpers. 

If the safe mode jumpers have been set, click ‘Yes’.  
CPR Toolbox will prompt for a suitable ARDS file. 

 

 

 

 

 

If the safe mode jumpers have not been set, 
click ‘No’.  CPR Toolbox will respond with a 
message box allowing the user to first set the 
safe mode jumpers before clicking ‘OK’ to 
continue. 
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The selection of an appropriate ARDS file begins by selecting a profile folder.  Navigate within 
the profile folder to the ARDS folder which stores all generated .ards files. 
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Figure 84 - Selecting a previously generated .ards file 

 
Upon selection of an .ards file, CPR Toolbox will attempt to 
start the drive using the ARDS information.  If the drive 
starts successfully, a message to that effect will be 
displayed. 

 
  



Modifying a Hardware Head Map vs. Creating a Software Head Map 
When working with a hardware head map, we can disable a given head or heads.  Attempts to 
read from these heads will result in errors.   
Through the utilization of a software head map16, we are able to determine the range of sectors 
for which each head is responsible.  Through the application of the map, we can simply bypass 
sector ranges, thereby avoiding errors.  Software headmaps are used by the ADR module. 
 
Modify Hardware Head Map 
Selecting ‘Modify Hardware Head Map’ will present a message box which enables the user to 
toggle each head on or off.   

 
Figure 85 - Modify Hardware Head Map 

 

Create Software Head Map 
Selecting ‘Create Software Head Map’ will instruct CPR Toolbox to create a head map from 
firmware modules and will write the data to a .map file. 

A message box is displayed showing the location and name of the stored .map file. 

 
Figure 86 - Saving a software head map 

 

  

                                          
16 Headmaps are used by the ADR utility. 
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View Software Head Map 
Selecting ‘View Software Head Map’ will instruct CPR Toolbox to display an ‘open file’ dialog box 
so that the user may select a .map. 

 
Figure 87 - Selecting a software head map file 

 

Selecting a .map file will instruct CPR Toolbox to parse the data within the file and create a text 
file with the parsed information. 

Upon selection of a .map file, CPR Toolbox will ask if the user wishes to reparse head map 
information.  

 
Selecting OK will open the text file created from parsing the .map file.  Selecting ‘Cancel’ will 
instruct CPR Toolbox to reparse the head map data and will overwrite the selected file. 
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A sample of the displayed data appears below.  The entries are produced in columns, one per 
head. 

For this example, some data has been colored to help explain the layout and meaning of the 
entries.  The lines colored in red outline the number of heads [00] through [04], and the 
number of entries for each of the heads listed. 

The lines colored in blue, list a head number followed by a range of LBAs for which the head is 
responsible. 

 

 

 
 

[00][Total Entries:44385] [01][Total Entries:88769] [02][Total Entries:88769] [03][Total Entries:88769] [04][Total Entries:88769] 
[00][5872       -   8175] [01][4720       -   5871] [02][3568       -   4719] [03][2352       -   3567] [04][1200       -   2351] 
[00][19920      -  22223] [01][8176       -   9327] [02][9328       -  10479] [03][10480      -  11695] [04][11696      -  12847] 
[00][33968      -  36271] [01][18768      -  19919] [02][17616      -  18767] [03][16400      -  17615] [04][15248      -  16399] 
[00][48016      -  50319] [01][22224      -  23375] [02][23376      -  24527] [03][24528      -  25743] [04][25744      -  26895] 
[00][62064      -  64367] [01][32816      -  33967] [02][31664      -  32815] [03][30448      -  31663]                           

 Figure 88 - Sample head map file 

 
 
Backup All Modules 
Selecting this option will instruct CPR 
Toolbox to create backups of all modules 
from the selected source.  This can be a 
time consuming process; CPR Toolbox will 
display a progress indicator during this 
operation. 

CPR Toolbox will present an alert indicating that the backup process has 
completed.   

Backed up modules are stored in the ‘Modules’ folder within the current 
profile folder.  An example path: 
C:\Documents and Settings\Ray\My Documents\CPR Tools Utilities 
Suite\iFirmware\Maxtor 6Y250P0_Y652N29E\Modules 

Within this Modules folder, CPR Toolbox has created a date and time stamped folder which 
contains the backed up modules.  Following the example above, the full path to the backed up 
modules would be: 
C:\Documents and Settings\<user>\My Documents\CPR Tools Utilities Suite\iFirmware\Maxtor 
6Y250P0_Y652N29E\Modules\01Dec2009_083501AM 
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Restore All Modules 
Selecting ‘Restore All Modules’ will provide the user with the ability to select a previously 
backed up module set. 

 
Figure 89 - Selecting a previously backed up module set 

 

To restore a module set, select the desired folder and click OK.  

This can be a time 
consuming process; CPR 
Toolbox will display a 
progress indicator during 
this operation. 

 

CPR Toolbox will present an alert indicating that the restore process 
has completed. 
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Service Area Input Source 
The iFirmware™ application has the ability to Backup, 
Restore and Verify the service area of a given source.  A 
source can be a connected hard drive or a previously backed 
up set of service area data.  Select a source from the drop-
down list to begin. 

Once a source has been selected, the Service Area 
Commands dropdown will be populated. 

 
 

 

 

 
Service Area Commands 
Backup Service Area 
Selecting ‘Backup Service Area’ will instruct CPR Toolbox to save a copy of the service area data 
to a file.  This can be a time consuming process; CPR Toolbox will display a progress indicator 
during this operation.  

 

 
 
 
 

When the backup of the service area has completed, CPR Toolbox will present a message box 
alerting the user to the location of the saved data. 
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Restore Service Area 
Selecting this option will provide the user with the ability to select a previously backed up 
service area. 

 
Figure 90 - Selecting a service area backup for restoration 

 

Ensure that the Service Area Input is a connected drive, or a file in a previously saved location.  
Note: You cannot select a file that is currently in use, this will fail because the restore file is 
already open. 

To restore from a previously backed up set of service area data, select a file and click ‘Open’. 

This can be a time consuming process; CPR Toolbox will display a progress indicator during this 
operation. 

 
 
When the restore process has completed, a message box 
is shown. 
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Verify Service Area 
Two types of verification are available.  These are 
Quick Verify and Full Verify 

Quick Verify 
Selecting Quick Verify instructs CPR Toolbox to 
validate firmware modules for the selected source. 

If verification fails, the user may wish to select 
this source as a ‘Repair Source’ in the Automatic 
Identification and Repair (AIR) section to attempt 
a repair of failed modules. 

Full Verify 
Selecting Full Verify instructs CPR Toolbox to verify the entire Service Area of the selected 
source. 

Automatic Identification & Repair (A.I.R) 
A powerful feature of CPR Toolbox’s iFirmware application is the ability to repair and/or replace 
firmware modules. 

To begin, select from the list under ‘Patient Drive/Files’.  Suitable sources may either be a drive 
connected to Side A of PSIClone, or a previously saved firmware module folder.  In the example 
shown, a hard drive on Side A of PSIClone has been selected. 

 
Figure 91 - A.I.R. with Patient Drive selected 
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Verification of modules 
Verification of modules is the preferred first step.  Begin by selecting 
modules listed for which verification should be performed.  Modules may 
be selected individually by clicking the checkbox to the left of each 
module name.  CPR Toolbox also provides a right-click context menu if 
selecting more than a few modules at a time is desired.   

‘Select by Module State’ and ‘De-Select by Module State’ provide the 
following sub-options: 

• Error 
• Not Verified 
• Valid 

Select by Importance and De-Select by Importance provide the following sub-options: 
• Level 1 
• Level 2 
• Level 3 
• Level 4 
• Asterisk (*) 

As stated earlier, module importance are noted on a scale from one (1) to four (4) where one 
(1) is the most important and four (4) is far less important.  Where an asterisk (*) is listed, the 
importance has not yet been 
determined.17 
Lastly, the user may Select All or 
Select None. 
Verification 
The verification state of a module is 
indicated by the icon which is 
presented between the checkbox and 
the module name.  Unverified 
modules are marked by a blue circle 
with a question mark.  Verified 
modules are marked by a green 
check mark.  Error modules are 
marked by a red circle with an 
exclamation point. 

In the example shown, all modules 
were selected and the ‘Verify’ button 
has been clicked to initiate the 
verification process.   Note that the 
module FW has failed verification and 
is marked by a red circle with an 
exclamation point. Figure 92 - Verification of modules 

Once the verification process has completed, a message box is 
shown.   

 
 

 

                                          
17 CPR Tools is continuing research into the importance of modules that are currently undetermined; as new 
information is confirmed, updates to this application are provided through new CPR Toolbox™ releases. 
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If a module fails verification, it will remain checked, as depicted in Figure 92.  At this point a 
repair may be attempted by clicking the ‘Repair’ button.  

Alternately, the user may choose to select a ‘Replacement Module Source’ from the drop-down 
menu at the right of the screen.  Available sources include a hard drive connected to Side B of 
PSIClone or a previously saved module folder. 

To replace a module, select the module to be replaced under the ‘Repair Source’ listing by 
ensuring it is checked, then click the ‘Replace’ button.  The ‘Replace’ button only becomes 
available if data is listed in the ‘Replacement Module Source’ section of the interface. 

If the repair or replacement of a given module is successful, the icon will change to a green 
check mark.  Not all module repairs will be successful; the resulting state of the module is 
indicated by the icon beside its check box. 

  



Module and Service Area Viewers 
Both Module and Service Area Viewers are available from within the 
iFirmware application.  These are ‘docked’ at the right of the screen and 
may be made to ‘fly out’ into the visible space by clicking either of the 
tabs shown.  The viewers may be ‘locked’ into the viewable space by 
clicking the push pin icon at the upper right corner of the viewer screen. 
Module Viewer 
To populate the Module Viewer with module data, first select a Module 
Input Source from the dropdown menu at the left of the screen; this is 
depicted here, encircled in red. 
To begin, first select a ‘Module Input Source’ from the dropdown menu at 
the left of the screen.  Suitable sources include a drive connected to 
PSIClone or a previously saved module backup. 
Once a Module Input Source has been selected, click on or hover the 
mouse over the tab labeled Module Viewer at the right of the screen to 
cause the Module Viewer to ‘fly out’. 
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The Module Viewer toolbar is located at the bottom of the viewer interface. 

 
To populate the viewer with module data, select a module from the dropdown at the bottom 
left.  Once a module has been selected, the user may scroll through modules by using the ‘Prev’ 
and ‘Next’ buttons, or by direct selection of another module using the dropdown box. 
The Module Viewer offers specific functionality not found in other 
areas of the iFirmware application.  The Module Commands 
dropdown menu provides access to the following options : 

• Save Module Map 
• Backup Current Module 
• Restore Single Module 
• Verify Module 
• Repair Module 

Select ‘Save Module Map’ to save the module map.  This 
functionality is the same as that shown in the ‘Select Module 
Source’ area of the screen.  The Backup, Restore, Verify and 
Repair options enable the user to work with individual modules. 

Editing within the Module Viewer 
There is a button, marked ‘Read Only’ at the bottom right corner of the Module 
Viewer.  In its initial state, the Module Viewer allows for the viewing of modules 
only.   
To enable editing of module values, click the ‘Read Only’ button.  When in 
read/write mode, the button will display a red X in place of the green checkmark.  
When editing module data is complete, be sure to click the button marked ‘Save Changes’ to 
commit the changes. 
Context Menu (right-click) within the Module Viewer 
Using the context menu within the Module Viewer provides easy switching 
from read only to read/write.  Additionally, there are some actions available 
only through the context menu.  Cut, Copy, Paste, Load From File and Save 
To File are functions which are only available through the context menu. 
Both ‘Load From File’ and ‘Save To File’ provide options to load or save in 
Hexadecimal or ASCII. 
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Service Area Viewer 
The Service Area Viewer allows for the viewing and editing of service area 
data. 
Begin by selecting a Service Area Input Source.  Valid sources are 
previously saved service area data or a drive connected to either Side the 
PSIClone. 
Once a Service Area Input Source has been selected, click on or hover the 
mouse over the tab labeled Service Area Viewer at the right of the screen 
to cause the Service Area Viewer to ‘fly out’. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Service Area Viewer includes controls at the top of the screen for navigating through 
Service Area LBAs (SLBAs).  Users may scroll through SLBAs one at a time or jump to the First 
or Last SLBA.  Alternately, the bottom, horizontal scroll bar may be used to scroll through 
SLBAs. 

At the bottom of the Service Area Viewer there are three (3) buttons.   

 
The Service Area Commands button provides the facility to backup or restore the service area. 
As with the Module Viewer, there is a toggle for setting the Viewer to Read Only or Read/Write 
status.  If changes are made in Read/Write mode, ensure that the Save Changes button is 
clicked to commit any edits. 
The context menu, available by clicking the right mouse button, also 
provides certain functionality, and is depicted here.   
The Set Read/Write selection performs toggling of the read-only switch. 
The Copy and Save to File options offer the ability to save or copy as 
ASCII or Hexadecimal. 
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Mount / Unmount Drive 
CPR Toolbox™ Tips: 

Mounted Drives are ‘READ ONLY’. 

No write operations may be performed on a 
drive which is in ‘Mass Storage’ mode while 
connected to PSIClone™. 

 

(Featuring USB Write-Block) 

CPR Toolbox™ now provides the ability to use a drive 
connected to Side B of PSIClone™ as a USB 
connected mass storage device (removable hard 
drive).  To begin, click on a drive connected to either 
Side of PSIClone™ in the left vertical pane of CPR 
Toolbox™.   Figure 93 shows a PSIClone™ with two 
drives connected.   

To mount the drive connected to Side B, select ‘Mount Drive’ from 
the Data Recovery menu button. Upon initiating the mounting of 
this drive, CPR Toolbox™ displays this message: 

Figure 93 – PSIClone™ with 
two drives connected 

 

 

 

 

 

 

 

 

 

 
When the switch to mass storage has completed, CPR 
Toolbox™ presents an informational dialog showing the 
drive and its connection point to PSIClone™. 

 

CPR Toolbox™ changes the display in the left, vertical pane 
to indicate that PSIClone™ is being used as a USB pass-

through to enable the host 
system to ‘see’ the attached 
drive.  Figure 96 depicts CPR 
Toolbox™ new display of the 

drive, including the operating system’s assigned drive letter.  
Additionally, the device LCD will display ‘PSICLONE MASS STORAGE’. 

PSIClone™ Tips: 

There is a direct relationship between the size of a drive being mounted and the time it will take to complete 
the transition to a write-blocked, mounted drive.  Large drives take a significant amount of time to become 
available as mass storage devices. 

Figure 94 – Mounting a Drive 

Figure 96 - CPR Toolbox™ has 
successfully mounted the drive attached 

to PATA B 

Figure 95 - CPR Toolbox™ 
reflects the mounted drive 

While in Mass Storage mode, the CPR Toolbox™ Sector Viewer may be used but other 
PSIClone™ / CPR Toolbox™ functions are disabled.  The switched drive may be addressed 
through the host operating system using the drive letter provided; in the example shown, drive 
letter “I:” has been assigned. 
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Why use the Mount Drive feature? 

Of the many reasons why the ability to use PSIClone™ to mount a 
drive is useful, two are presented here: 

I. One reason for using with the ‘Mount Drive’ feature of 
PSIClone™ and CPR Toolbox™ would be to assign a drive 
letter to the drive which has just been used as the destination 
of an image fileset.   

By assigning an operating system addressable drive letter to 
this drive, an external utility, like the included ‘Mount Image 
Pro’ software can be used to mount the image.   

Once the image fileset has been mounted, a utility such as 
the included ‘Recover My Files’ software can be used to 
perform data recovery actions without the risk of altering the 
original data from which the image was made. 

II. Once a drive has been mounted, files may be ‘dragged’ using 
Windows Explorer, effectively copying them to the host 
system. 

III. PSIClone™ initiates a USB Write Block for drives mounted 
using the ‘Mount Drive’ feature.   
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Security 
Clicking the ‘Security’ button reveals the menu item which launches DriveKey™. 

 
DriveKey™ 18 
What is DriveKey™? 
DriveKey™ represents a breakthrough in hard drive security manipulation.  On fully 
supported drives19, DriveKey™ is able to retrieve the drive’s security password, even 
if the drive was locked with the highest level of security supported by the ATA 
specification. 

For drives which are fully supported, DriveKey™ allows the retrieval of passwords which are in 
effect. For supported and unsupported drives, DriveKey™ acts as a user-friendly front-end to 
the locking and unlocking of drives at all security levels. 

Launch DriveKey™ by clicking the Security button in the CPR Toolbox™ toolbar to reveal the 
DriveKey™ menu item. Click DriveKey™ to begin. 

User and Master Passwords 
To understand the benefits of DriveKey™, a 
description of the workings of locking and unlocking 
drives using ‘User’ and ‘Master’ passwords is presented 
here. 

DriveKey™ is a user interface which allows easy 
manipulation of the password security features implemented in the ATA specification.20 

NOTE: 
Supported drives on either Side A 
or Side B of PSIClone™ may be 
locked or unlocked using 
DriveKey™. 

Security enabled ATA compliant hard drives use passwords to allow for security to be applied.  
These passwords, called ‘User’ and ‘Master’ may be used separately or together.  The level of 
security depends entirely upon the choices made regarding which passwords are used. 

Contrary to the naming conventions, the ‘User’ password is 
used to provide security.  ‘Master’ passwords are used solely 
as an alternative method of unlocking a drive in certain 
instances. 

DriveKey™ Key Feature:  
Prior to DriveKey™, a drive 
locked with a User Password 
would be unusable without the 
User Password. 

With DriveKey™ support, this 
is no longer the case; fully 
supported, locked drives may 
simply be unlocked using 
DriveKey™. 

To lock a drive, ‘User’ password must be used.  The ‘User’ 
password has two possible levels of security:   

High 
If a drive is locked with a user password in ‘High’ 

mode, either the Master password or User 
password may unlock the drive. 

Max 
If a drive was locked with a user password in ‘Max’ mode, only the User password 

should be able to unlock the drive.  The drive should be completely unusable 
without the correct ‘User’ password.   

                                          
18 Available as an add-on module to Law Enforcement and Government Agencies only; additional charges apply.  
Contact CPR Tools, Inc. for more information 
19 A current list of fully supported drives is available online at http://www.cprtools.net/downloads 
20 The ATA specification is maintained by INCITS T-13 committee (http://www.t13.org) 

http://www.t13.org/


 
DriveKey™’s feature set is best described through example.  The first example will assume a 
fully supported drive so that all of DriveKey™’s features will be displayed. 

Fully Supported Drives and DriveKey™ 
Assumptions for this example: 

A fully supported drive21 is connected to PSIClone™ on Side B and is powered. 
PSIClone™ has been attached to a USB 2.0 port on a host computer running CPR Toolbox™ 

version 5.0 or higher22. 
DriveKey™ support has been enabled23. 

Figure 97 - DriveKey™ initial screen 
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21 A current list of fully supported drives is available online at http://www.cprtools.net/downloads 
22 The images presented may not accurately depict CPR Toolbox versions < 5.0, however functionality on these 
versions is the same. 
23 Available as an add-on module to Law Enforcement and Government Agencies only; additional charges apply.  
Contact CPR Tools, Inc. for more information 

 



Using DriveKey™ 
Begin by selecting a supported drive from the drop-down list, labeled ‘Target Drive’.  Figure 98 
depicts a Maxtor Drive, attached to Side A of PSIClone™ selected.  

 
Figure 98 - A Maxtor drive attached to Side A of PSIClone™ has been selected 

Select a drive from the drop-down menu labeled ‘Target Drive’.  Drive security status is 
provided in the section to the right labeled ‘Security Info’. 
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The ‘Password(s)’ section of the screen, depicted in Figure 99, provides an interface through 
which a drive may be locked or unlocked.   

 
Figure 99 - Password Settings Section of DriveKey™ 

In this section, the user will be able to read/display Master and User passwords.  Additionally, 
the user may set a Master password and/or a User password in either High or Max modes.  The 
passwords selected may be in either ASCII or Hex.   

Setting a Master Password24 
To set a Master password, 
ensure that the radio button 
labeled ‘Master’ is selected.  
Next, select either ASCII or 
Hex and enter a ‘Fill Value’, if 
desired, in the text box 
provided.  The ‘Fill Value’ is 
used to pad the chosen 
password.  If no Fill Value is 
entered DriveKey™ will pad the password field, if needed with 0x00.   

Key a password into the field shown.  

 

                                          
24 DriveKey is capable of setting Master passwords on both fully supported and minimally supported drives 
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According to the ATA specification, a Revision code may be set to specify information about the 
entity setting a security password.  As not all vendors follow the specification, this field may be 
‘grayed out’.  The ATA specification indicates that valid hexadecimal values for Revision are 
0001 through FFFE. 

Click ‘Set’ to set the Master password.   

Upon successful setting of the Master password, 
CPR Toolbox™ will display a confirmation message, 
shown in Figure 100. 

In addition to the success message, CPR Toolbox™ 

displays the output of the command in the Event 
Log section of the module, as shown in Figure 101. 

Figure 100 - Successfully set a password 

 
Figure 101 - Output resulting from successful setting of Master password 

The password is displayed in both ASCII and Hex.  Note that as the password phrase entered 
did not fill the requisite 32 bytes, the ‘Fill Value’ was appended to the phrase to pad it to the full 
length of the password field. 

The output in the Event Log may be saved to a file by clicking the ‘Save’ button.  Alternately, 
this data may be easily printed by clicking ‘Print’.  The Event Log display may be cleared by 
clicking ‘Clear’. 

DriveKey™ Key Feature:  
Prior to DriveKey™, a drive 
locked with a User password 
would be unusable without the 
User password. 

With DriveKey™ support, this 
is no longer the case; fully 
supported, locked drives may 
simply be unlocked using 
DriveKey™. 

Setting a User Password25 
The process for setting a ‘User’ password closely resembles 
those for setting a Master password as described above.  One 
significant difference is the ability to choose a security level 
for the User password.   

As with the setting of the Master password, the user must 
select ASCII or Hex, ‘Fill Value’, if desired, in the text box 
provided.  The ‘Fill Value’ is used to pad the chosen password.  
If no Fill Value is entered DriveKey™ will pad the password 
field, if needed with 0x00.   

  

                                          
25 DriveKey™ is capable of setting User passwords on both fully supported and minimally supported drives 
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The ‘User’ password has two possible levels of security:   
High 

If a drive is locked with a user password in ‘High’ mode, either the Master password 
or User password may unlock the drive. 

Max 
If a drive was locked with a user password in ‘Max’ mode, only the User password 

should be able to unlock the drive.  The drive should be completely unusable 
without the correct ‘User’ password. 

To set a User password, ensure that the radio button labeled ‘User’ is selected.  Next, select 
either ASCII or Hex and 
enter a ‘Fill Value’ in the 
text box provided.   

The ‘Fill Value’ is used to 
pad the chosen password.  
Select ‘High’ or ‘Max’. 

 

Key a password into the field shown.   

Click ‘Set’ to set the User password.  CPR Toolbox™ 
displays a confirmation message to acknowledge 
the setting of the User password, as shown in 
Figure 102. 

Once a password has been set, the drive is locked.  
PSIClone™ recognizes this and presents a locked 
icon adjacent to the drive as displayed in the 
vertical pane in CPR Toolbox. 

Figure 102 - User Password Set 

Retrieve 
For fully supported drives, any passwords which exist may 
be shown within the DriveKey™ module by clicking 
‘Retrieve’.  If ‘Retrieve’ is used on drives which are not fully 

supported, CPR Toolbox™ displays a message stating that 
the selected drive is not yet supported. 

Figure 103 - PATA A is Locked 

 
 

 

 

 

 

If ‘Retrieve’ is successful, CPR Toolbox displays a confirmation that the retrieval was successful. 
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Click ‘OK’. All known password information about the drive is displayed in the Event Log 
window.  A successful ‘Retrieve’ operation is shown in Figure 104. 

 
Figure 104 - Successfully retrieved password information is displayed 

The output in the Event Log may be saved to a file by clicking the ‘Save’ button.  Alternately, 
this data may be easily printed by clicking ‘Print’.  The Event Log display may be cleared by 
clicking ‘Clear’. 

Permanent Unlock 
The button marked Permanent Unlock may be 
used to unlock a drive in such a way as to have 
the ‘unlocked’ status survive a power cycle of the 
drive.  This feature is available to fully supported 
drives under most conditions.  For drives which 
are not fully supported, this feature will only 
succeed if the password(s), if any, for the drive 
are known. 

To use the ‘Permanent Unlock’ feature for fully supported drives, first click ‘Retrieve’ to 
populate the password field.  Once the password field is populated, clicking the ‘Permanent 
Unlock’ button will unlock the drive.  CPR Toolbox™ will display a confirmation message upon 
success. 

The Event Log will show an entry upon successful unlocking of a drive, as shown encircled in 
red in Figure 105. 

 
Figure 105 - Event Log provides a summary of the unlocking process 

The output in the Event Log may be saved to a file by clicking the ‘Save’ button.  Alternately, 
this data may be easily printed by clicking ‘Print’.  The Event Log display may be cleared by 
clicking ‘Clear’. 
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Reporting 
Click the ‘Reporting’ button to access reporting functions within CPR Toolbox™.  The main 
reporting screen is depicted in Figure 106. 

 
Figure 106 - Reporting - initial screen 

The main reporting screen displays five (5) tabs.  These are: 
• Jobs 
• Certificates 
• Print Labels 
• Device Log 
• Alert Settings 

The first four (4) tabs are used when CPR Toolbox™ is connected CPR Tools’ data eradication 
devices: Hammer™ and SCSI Hammer™.  PSIClone™ users need only be concerned with the 
‘Alert Settings’ tab, depicted in Figure 107. 

 
Figure 107 - Alert Settings, initial screen 
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The Alert Settings tab is used to send email alerts at specific times during a recovery effort 
(internet connection and valid email credentials required).  To configure CPR Toolbox™ to send 
email alerts, begin by selecting a device from the dropdown list, as shown.  Alternately, users 
may configure CPR Toolbox™ to work with 
multiple CPR Tools devices by clicking the 
‘Add Device’ button.  Clicking ‘Add Device’  
will cause CPR Toolbox™ to display a 
dialog box which will collect information 
about specific CPR Tools devices 
(Hammer™, SCSI Hammer™ & PSIClone™) so that specific alert settings may be saved for 
those devices on the host.  This feature allows users to configure alerts for devices without 
needing to connect those devices to a host. 
 

Devices added in this fashion will be available in the 
‘Selected Device’ drop-down box and may be selected for 
editing at any time.  These settings will automatically 
activate when the device for which they were configured is 
connected to CPR Toolbox™. 
 
 
 
 
 
 

Once a device has been selected, configuration of the 
alert settings for that device may begin.  Start by 
completing the ‘Email Settings’ box at left, shown in 
Figure 108. 
Enter a valid email addresses in the Sender and 
Recipient fields.  Enter a valid mail server address in the 
Server Name field.  If your mail server requires 
authentication for sending emails, check the box marked 
Authentication Required. 
To test your settings, click the ‘Test Settings’ button.  

Doing this will instruct CPR Toolbox™ to send a test 
message using the values configured for Sender, 
Recipient and Server Name. 

Figure 108 - Email Settings 

If the test message is sent successfully, CPR Toolbox™ presents a message box to that affect. 
The recipient specified in the ‘Recipient’ field will receive a test 
email similar to what is depicted in Figure 109. 
 
 
 
 
 
 
 

Email settings test email. 
Sender: alerts@example.com 
Recipient: technician@example.com 
Server: mail.example.com 
Authentication Required: Yes 
 

Figure 109 - Sample test email 
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mailto:alerts@example.com
mailto:technician@example.com


Once the email settings have been configured, enable or modify the ‘Alert Settings’ in the box 
at right. 

 
Figure 110 - The 'Alert Settings' box 

 

The Alert Settings box provides options which determine when alerts are sent when using the 
selected device.   

Select the ‘Alert on Start’ checkbox to instruct CPR Toolbox™ to send an alert when an action is 
initiated.   

Select the ‘Alert Every’ and select a number of minutes for periodic updates to be sent.   

Select the ‘Alert Every’ and select a value for percentage to receive periodic updates based on 
the percent complete.  

Select ‘Alert on Error’ and choose ‘First’, ‘All’ or ‘Every’  to receive alerts when errors occur.  
The ‘Every’ option requires a number of errors which must occur before an error alert is sent. 

Select ‘Alert on End’ to be alerted when the current action completes. 

Assuming that the email configuration is correct, CPR Toolbox will send alert emails at the 
defined intervals.   
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FAQ / Troubleshooting 
1. After starting PSIClone™, LCD does not light, device is unresponsive. 

Ensure power cable is connected to the device and a working power source.  
 

 

2. PSIClone™ does not recognize one or more attached PATA drives. 
 Ensure all attached PATA drives are set to ‘Master’.  

Ensure that no more than two drives (one on each side of the device) are 
connected.  Do not use power splitters when working with PSIClone™. 
 

 

3. CPR Toolbox™ does not display any attached CPR Tools devices. 
 Ensure USB Cable is attached to both PSIClone™ and the host PC. 

Only USB 2.0 is supported. 
 

 

4. Windows® asks for a driver when I plug in PSIClone™ to a USB port on my PC. 
There are two (2) potential reasons why Windows may ask for a driver to be 
installed. 

 

o This is a new installation.  The correct driver for PSIClone™ is pre-
installed upon installation of CPR Toolbox™ (part of the CPR Tools 
Utilities Suite installation).   

o RESOLUTION: 
When the ‘Found New Hardware’ wizard appears: 
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a. Select ‘No, not this time’ when asked if Windows should 

connect to the Windows Update site; click ‘Next’ 

b. Select ‘Install the software automatically (Recommended); 
click ‘Next’ 
 

 

c. Select ‘Continue Anyway’ if presented with the notice that 
this driver has not passed ‘Windows Logo Testing’. 
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d. Click ‘Finish’ to complete the driver installation. 
 
 

o PSIClone™ is connected to a USB 1.1 port  
o RESOLUTION: USB 2.0 is required.  
o CPR Tools recommends updating PSIClone™ to the most recent 

firmware available using the CPR Flash utility which ships with 
PSIClone™. 
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5. Windows® asks me to select from a list of installed drivers when I connect PSIClone™, 

Hammer™ or SCSI Hammer™ to my host system, as shown below: 
 

 
 

This is known to occur when several iterations of legacy CPR Tools device drivers 
exist on the host system. 

 

o RESOLUTION: Always select the driver marked CPR 1010 CONFIG.  This is 
case sensitive – note that the word CONFIG is in all capital letters. 

o This driver selection will only be required once.  Once selected, 
click ‘Next’ and complete the ‘Found New Hardware Wizard’.  
PSIClone™ may then be used with the host system and CPR 
Toolbox™. 
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Product Specifications 
 

CHARACTERISTIC SPECIFICATION 

Drive Interfaces: Parallel ATA (PATA) & Serial ATA (SATA) 

Host Interface: USB 2.0 

Max Transfer Rate: Up to 4.0 Gigabytes per minute 

Input Voltage: Max: 3.5 A / Typical: 1.6 A 

Input Current: +12 VDC 

Voltage Supplied to Drives: +12VDC, +5VDC 

Operating Temperature Range: 0o to 50o Celsius 

Storage Temperature Range: -20o to 60o Celsius 

Operating/Storage Humidity Range: 5% to 95% (non-condensing) 

Device Addressing Support: 28 bit and 48 bit supported 

Max Transfer Mode: UDMA Mode 4 

Supported Protocols: ATA 4 through ATA 7 

Dimensions: 4.15” L x 1.41” H x 4.16 ” W 

Approx. Device Weight: 11 oz. 
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Glossary of Terms 
ATA 
AT Attachment, defines the physical, electrical, and command protocols for the internal 
attachments of storage devices to a host.  PSIClone™ supports devices that conform to ATA 
specification 4, 5, 6, or 7.  Also See PATA and SATA. 

 ATA Device 
Any device that conforms to the ATA specification.   

Bang 
CPR Tools’ term for writing a pre-defined pattern to a drive.  This function is used for erasing 
(overwriting data on) a drive.   

Clone 
To copy all data from one drive and write it to another, creating an exact copy of the source 
drive.  The cloning process copies data on a sector-by-sector basis.  PSIClone™ copies from a 
drive attached to side A to a drive attached to side B.   

Compare 
PSIClone™ performs compare operations on a ‘byte-by-byte’ basis. 

The compare command is used to compare a drive attached to Side A of the PSIClone™ to a 
drive attached to Side B of the PSIClone.  This is used for validating the results of a clone. 

You may also compare a drive to any ‘bang’ pattern (other than random).  This is used to 
validate that the selected pattern was written. 

Hash 
A hash function is a reproducible method of representing a data stream as a (relatively) small 
number that may serve as a digital "fingerprint" of the data. The algorithm substitutes or 
transposes the data to create such fingerprints. The fingerprints are called hash sums, hash 
values, hash codes or simply hashes. (Note that hashes can also mean the hash functions.)  
PSIClone™ employs the MD5 hash algorithm to generate hashes.  These are intended to be 
used as validation that a clone is a true and accurate copy of the original source. 

Image 
A disk image is a computer file or a group of computer files (known as a fileset) containing the 
complete contents and structure of a data storage medium or device, such as a Hard drive, CD 
or DVD. The term has been generalized to cover any such file, whether originated from an 
actual physical storage device or not. As such, a disk image contains all the information 
necessary to replicate the structure and layout, as well as the actual contents, of a storage 
device, and this is the distinguishing feature between an ordinary backup and a disk image. A 
disk image file or fileset is usually created based upon the sectors on the medium, ignoring its 
filing system. 

PSIClone™ creates image filesets.  The size of individual files within an image fileset is defined 
in the options section of the PSIClone™ menu and may be 700 MB, 1 GB or 2 GB.  The 700 MB 
option is provided to facilitate copying of image files to CD media.  PSIClone™ is also capable of 
creating compressed images.  Refer to the Image portions of this manual for details. 

LBA 
Logical Block Address, the address given to each sector in the device.  PSIClone™ prints an 
“LBA” number upon completion of the identify device command.  This number, presented in 
decimal format, represents the total number of LBAs that the device can access ideally. 
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MD5 Hash 
In cryptography, MD5 (Message-Digest algorithm 5) is a widely used to check the integrity of 
files. 

An MD5 hash is typically expressed as a 128 bit (16 byte) value.  PSIClone™ displays MD5 hash 
values in hexadecimal format. 

PATA 
Parallel ATA, describes the physical and electrical hard drive interface that uses a 40 pin 
connector to interface with host and device.  PSIClone™ incorporates a PATA interface on side A 
and another on side B. 

PIO 
Programmed Input/Output, transferring data between device and host one sector at a time.  
Also PIO mode is used to send commands to an ATA device.  PIO mode is the slowest means of 
transferring data between a host and a device. 

Power Cycle 
Involves powering off a drive, waiting for a short delay, then powering the drive on and waiting 
for the duration set by ‘Power on Delay’ before proceeding.   

SATA 
Serial ATA, describes the physical and electrical hard drive interface that uses a 7 pin connector 
to interface with host and device.  PSIClone™ incorporates a SATA interface on side A and 
another on side B. 

Sector 
A group of 512 bytes that has a unique address (LBA).  This is the smallest amount of data that 
can be addressed at a time from the ATA interface. 

UDMA 
Ultra Direct Memory Access, transferring data between device and host in bursts of multiple 
sectors at a time, bypassing the CPU.  There are seven UDMA modes with mode 6 yielding the 
fastest transfer rate and mode 0 yielding the slowest transfer rate.  PSIClone™ currently 
supports up to and including mode 4.  

  



Customization 
Customizing the Look and Feel of CPR Toolbox™ 
The default logo presented in the main CPR Toolbox window can be customized.  To add a 
custom logo to CPR Toolbox: 

1. Create a Bitmap Image file (.bmp) to be used as the custom logo/background image 
2. Place your image in the ‘User Data\Images’ folder under the installation folder for 

CPR Tools Utilities Suite (The default location is “C:\Documents and 
Settings\<user>\My Documents\CPR Tools Utilities Suite\Images”). 

3. Name this file backlogo.bmp 
4. Close and restart CPR Toolbox.  Your new logo will appear as the main window 

background. 

Using CPR Toolbox™ with Multiple CPR Devices 
CPR Toolbox™ was designed to simplify working 
with CPR Devices (PSIClone™, Hammer™, etc…).  
One key feature of CPR Toolbox™ is the ability to 
work with multiple CPR Devices at the same 
time.   

CPR Toolbox™ displays all connected devices 
(and the drives connected to them) in the 
horizontal pane at the left of the screen, as shown below. 

CPR Toolbox™ Tips:  

Use CPR Toolbox™ to manage and control 
multiple CPR Devices.  Commands issued 
run concurrently; this saves time and 
increases productivity. 

A key feature of using CPR Toolbox™ to control multiple devices is the ability to perform actions 
simultaneously.   

Figure 111 - CPR Toolbox™ controlling multiple CPR Devices 

Figures 73 and 74 depict CPR Toolbox™ with three CPR Devices attached.   
Hammer™ Device (S/N 100467) is displayed performing an erasure.   
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Figure 112 - CPR Toolbox™ with multiple CPR Devices 
Hammer (S/N 100467) shown performing an erasure 

 

Figure 112 shows an erasure being performed by the Hammer™ device shown at the bottom of 
the left horizontal pane.  This is able to be determined by the red circle which highlights the 
Hammer™ icon in the left vertical pane. 

 
  CPR Toolbox™ Tips: 

When selecting a CPR Tools device (PSIClone™, 
Hammer™,  SCSI Hammer™, etc…) using CPR 
Toolbox™, the backlit LCD of the device will 
become illuminated to assist in identifying which 
device is selected. 
 
The LCD will not illuminate if the device is actively 
performing a command. 
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Customer Support 
For more information, please visit us on the World Wide Web at http://www.cprtools.net/. 

Technical support requests for the PSIClone™ should be sent via email to 
psiclone.support@cprtools.net. 

Visit http://www.cprtools.net for our complete offering of hardware and software for data 
recovery and data security including: 

 Hammer™ 
o Data eradication unit, suitable for lab or field work.  Securely erase data from up 

to four (4) drives at a time. 
 SCSI Hammer™ 

o SCSI Hammer™ brings secure data eradication to SCSI hard drives.  Securely 
erase data from up to thirty (30) drives at one time with SCSI Hammer™ 

 HDD Adapters 
o A full suite of sturdy adapters to simplify working with a variety of form factors. 

 Head Combs 
o Pre-fabricated head loaders; a must for hardware based data recovery efforts 

 BangDisk32™ 
o HDD Sanitizing utility for Microsoft Windows 

 AlarmDisk™ 
o Windows based system monitor, provides alerts to unauthorized HDD access 

Product specifications, user’s guides, instructional videos and more are available at 
http://www.cprtools.net/downloads. 

 

 

 

http://www.cprtools.net/
http://www.cprtools.net/downloads
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